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1728

1080

WLCSP36

QFN32

QFN48

4/5/6

LQFP144

QFN32U

GWINSE-2C

1728

1080

QFN48

LQFP144

5/6

GWI1NS-4

4608

3456

16

WLCSP49

QFN48

5/6

GWI1NZ-1

1152

864

WLCSP16

4/5/6

SUG100-1.9

6(83)




2 IR 2.2 WP HF
LRSS LUT4s Flip-Flops MULT18 x 18 PLL | &34 W
QFN32
GW1NSR-2 1512 1080 0 1 QFN48 4/5/6
GW1NSR-2C 1512 1080 0 1 QFN48 4/5/6
2 QFN48P 4/5/6
GW1NSR-4 4608 3456 16 2 QFN48G 4/5/6
2 MBGAG64P 4/5/6
2 QFN48P 4/5/6
GWI1NSER-4C 4608 3456 16
2 QFN48G 4/5/6
PBGA484
PBGA256
PBGA256C
GW2A-18 20,736 15,552 48 4 LOFP144 6/7/8
eLQFP144
PBGA256S
MBGA196
QFN88
LQFP144
GW2AR-18 20,736 15,552 48 4 LQFP176 6/7/8
eLQFP144
eLQFP176
PBGA484
GW2A-55 54,720 41,040 40 6 6/7/8
PBGA1156
Y
BAFRCAARTE, RS TRe s A 25, BAARE E1E S % I R CR .
SUG100-1.9 7(83)




3 WA A 3.11a17¥E

SRR HRE

’—
3.1 BITERE
Windows: Win7/8/10(64bit). Win7/winXP(32bit)
Linux: Centos6/7(64bit). Red Hat 6/7(64bit). SUSE 11/12(64bit)

32 HMHTH
Gowin Z V5 E 235404 A Windows R4S Linux fiiAs, 7] 38 it 2 5% 5
= FRE AT T AR

e Windows R4 NI LFRN “ = IRHAY for win(Vx.x.xBeta)” ,
AR www.gowinsemi.cn/fag.aspx
o Linux A& LA, LN “ =R for Linux(Vx.x.xBeta)”

NEGHE: www.gowinsemi.cn/fag.aspx

E!
o  RMFTEEI, ToREMEMNHER.
o MM BIEMEATE “VxxxBeta” F “x” RIRHAHIMAS .

3.3 MHRE
!
o 3 Gowin = YHEKAFHET, HISCH 360 541l # H SR B
o R AE IR AR AN SRR O A OB AR I SR AR 5
o WNTFLHHIA Gowin YEHAME, HIEIFE EMRAZ G, FIREE;
o  Windows NI SCRFERE RSy, RN B WK 3-1 B,
%% 3-1 Components to Install

Components g H/iE

Gowin FPGA Gowin =VEHAFEIEH | X N T HAT SO 2R H R T
designer GUI JaEi 8] \X.X\IDE\bin\gw_ide.exe

® U YR HAT A LR H R T
\X.x\Programmer\bin\programmer.e
Device Gowin s+ T # LH, 4 xe:

rogrammer £ A
prog programmer f§ i (£ © £ SRy K 4

\x.x\Programmern\doc.

SUG100-1.9 8(83)
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3 w2

3.3 Bz

SUG100-1.9

Components ik e

® UL HAT A LR H T
. \X.x\SynplifyPro\bin\synplify_pro.ex
Synthesis Gowin £ TH, AiH{l e

=
tool ik o REHM R E
. x\SynplifyPro\doc.

Windows 2%t

£ Windows 243 Gowin =i#fE, HS % T L.
1. Wil dety, MIEFRRBRIN 22,

!

o R FR A ARYE 7 U H

o ALY S, SBNATE PC MA@ KA
2. MEEPAETT A BT, 4TI Gowin =YK AT S o
Linux &%

fE Linux R4, fRESCHRIE, BATM T s
path/x.x.xBeta/IDE/bin/gw_ide, ] T F 444 A1 .
!
5 2% H root BLFR A ) programmer
¥
WA 2 w22 Gowin R, FRRZEIE, Tl SynplifyPro 484 1T E i H #4%
5 BGHRI Gowin IR e 38 B AR R AL T [/ — Ui R, BT iR R,
H“Tools > Options”, #AJEiE$E SynplifyPro B35 #4%, 4nk 3-1 SynplifyPro i 542
PR

3-1 SynplifyPro 1
I'\,a\( Options @1

Synplify Pro
Symplify Fro

%, Environment
@ Tefault (Synplify Fro for GIWIN)

= Text Editor _
©) Custom

’ External Editor Fath: Browse. .

€, synplify Pro I

[#]items request restart program 0K ] [ Cancel ] [ hpply

9(83)




3 mFRH s 3.4 BAEVE AT IE inEk (Windows)

3.4 THIFAEME (Windows)

37 5, FNEFEHAEEFAE (License) A Be1E% T4, Gowin
Zo VR A ) VF AT IE AL -

e SynplifyPro £x& T AVFAIE;
o iRtk TRVl

Gowin z PR3 AT UE S FE 5 S8 Y RTE (Node-Locked License)
AFEHVFATE (Floating License).

HEFE S E N www.gowinsemi.cn/fag view.aspx HiE

License.
AR AT UE A N #7415 2 % 3.5SynplifyPro License I#k % 3.6 fii
faAigk T E License f#k.

3.5 SynplifyPro License fl#k
3.5.1 T RABEIFAIE

B R UE R T AL MAC Huhik BT B A Al e, AR ASHLH P
i . Ye®| SynplifyPro (7 i BUE VFAIIESG , 125 DL T PR3
!
F1"C:\Synopsys\"# 1% T ekt ki TH, LR T4 license X, 2 55 Gowin i) synplify
1£34K license W& H IR A . KN synopsys 2 BRINERX AN 2~ 4K license, A
N ENIR AR,
PLR LA win7, 64 f{E RS NGI, B8 RGHELE.
1. {#1F License /4.
¥ 38151 SynplifyPro 1 License S (4 licensefile.txt) fRA7/EHE E H
T, Wl “E:\Synopsys\licensefile.txt” .
2. BN,

a). AR “THENL . EFE CRGRENET , B CRARSWE,
1 “A&gett” &0,

b). 7E“FRGEE L& 1 b R R TR, IR AT E S, TR
AR EREHE, Al 3-2 PR .

C). FE“HrE I AL BN A A N PR 5 AL B A B AN AL B

- MR EAFR: LM_LICENSE_FILE;
- AFHE{H: License X HIAFIA B , tn“E:\Synopsys\licensefile.txt”
3. $$ “Eﬁ%”o

SUG100-1.9 10(83)
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3.5SynplifyPro License hn#k

3 mIR s
B 32 IMEERRE
EREE =
[HEne | # |58 | Fuser|EE |
HEZE pg
[ remrz=s o
TEE W) IM_LICENSE_FILE|
TEE WV E:"Synepsyshlicensefile. txt
[ = [ BmE |
Se—
FERTE ()
T8 =} i+
ACTEL_FOE_AL. . .
ALTERA_FOE_&. ..
ComSpec C:'\Windowssystem32icomd. exe
FP_HN_HNST 1] S
[FEw... | (wEo.. | [ ®Weo |
= [ @z [ ®B& | U
~ Ly 3
3.5.2 BT ALIE

TRV IR AR TE RN N FE 2 — S VF IR IR S5 8%,  JRd M N i) PC & a]
R . FahreliEea AP BERS .
1. BEFshdEaiERS:, #F1#H Synopsys Common Licensing (SCL) %%
4, BRI 223540 R S0 “GowinLicenseServerForWindows\SCL”.
a). Hok s SCL $i47 ft “scl_v2018.06_windows.exe” #47 SCL
AR %S, R m P B T 223, Tl “Site
Information” S Al #E4T U0 FECE -
“Site ID”:3545 () SynplifyPro i License Sl synp_license.lic)
1] “siteid” FUHUE, 4029247;
“Site Administrator”: N & ASHLE FH 51 44 %
“Contact Information”: TJiEIEI, &F AR TR,

b). AJE AR e e n) R B RE kAT, WA
“C:\Synopsys\SCL”, wiii TP EBIHIE 2R A H,
“Completing the SCL 2018.06 Setup Wizard”, i “Finish” %
Hl5e i SCL 223k,

2. fE SCL Z&eitte T HEAF /% “2018.06\win32\bin”, 41

“C:\Synopsys\SCL \2018.06\win32\bin”, 7 #Fh 5 25 5% 50V AT IE

fR%, LLWin7, 64 fitdE 2% A1

SUG100-1.9 11(83)
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3 w2

3.5SynplifyPro License hn#k

SUG100-1.9

& 3-3 License

01/28/2019 09:16:06 (snpslmd) Siteid:
01/28/2019 09:16:06 (snnslmd)
9:

WO W0 W0 0 W0 W W W0 W0 W0 0 0 W W0 0 0 6 W W0 0 0

M

b)

license X AF % “SERVER hostnamel F8BC12950972 27020”
*ﬁEF':
“hostnamel” MAESCAANLITHHLAFR;
“F8BC12950972” NAMNLE] MAC Hutik;
“27020” Jyu 115, MRHE L SynplifyPro i EHLE BdtiT1&
WEMUE N“SERVER GaoYun-PC F8BC12950972 27020,

A& B VF AT IE SO 1 snpsimd #8428 :

HRE SCL ®fftrh snpsimd.exe %1%, &4 license (44
“VENDOR snpslmd /path/to/snpsimd” —47, Wifge)ah
“VENDOR snpsimd

C:\Synopsys\SCL\2018.06\win32\bin\snpsimd.exe” ;

c) fIHFemd &1, BT RN TIERS, PATHmESA
“path\Imgrd.exe” —c “path\licensefile” —I “path\logfile” -z —s;
d) E1r5Ete)E, &F log X1 (log X Fi#64% : path\logfile), ik License

MBI, WY, log KA 2 HILWTE 3-3 s

RERY

log 3Tt

uuuuuuuuuu ¥ eensousidwe LU e

29247, Server Hosgid: S25400BSABE7, Issued on: 12/18/2018

SCL AEEERR
a) BHUFSNVE A UE SO A AL FR A MAC ik,

16:06 (gnpslmd) SLOG: Statistics Log Frequency is 240 minute(s).

:16:06 (gnpslmd) SLOG: TS5 update poll interval is 0. TS update is detected by midnight reread only.
116:06 (gnpslmd) S5SLOG: Activation borrow reclaim percentage is 0.

:16:06 (snpslmd) (Esnpslmd-SLOGE)

116:06 (gnpslimd) (Bspnnslmd-SLOGE) === Vendor Daemon ===

:16:06 (gnpsimd) (Esnnslimd-SLOGE) Vendor daemon: gnpsimd

116:06 (sopslmd) (@snpslmd-SLOGE) Start-Date: Mon Jan 28 2019 09:16:06 CST

116:06 (gnpslmd) (Bsnpslmd-SLOGE) PID: 30659

116:06 (snpalmd) (Bsnpslmd-SLOGE) VD Version: v1l.14.1.3 build 212549 x64_lsb ( build 212549 (1pvé))
:16:06 (snpslmd) (Esnpslmd-SLOGE)

116:06 (gnpslmd) (Bgnnslmd-SLOGE) = Skartup/Restart Info =——

116:06 (gnpsimd) (Esnnslmd-SLOGE) Options file used: None

116:06 (snpslmd) (@snpslmd-SLOGE) Is vendor daemon a CVD: Yes

116:06 (gnpsimd) (Bsnnsimd-SLOGE) Is TS accessed: No

:16:06 (znpsimd) (Bsnnslmd-SLOGE) TS accessed for feature load: -NA-

116:06 (gnpslmd) (Bsnnslmd-SLOGE) Number of VD restarts since LS gharnup: 0

:16:06 (gnpalmd) (Bznpslmd-SLOGE)

:16:06 (znpslimd) (Bsnnslmd-SLOGE) === Network Info ===

116:06 (gnpslmd) (Bsnnslmd-SLOGE) Listening port: 37814

:16:06 (znpslimd) (Bsnnslmd-SLOGE) Dasmon select gimgout (in seconds): 1

:16:06 (gopslmd) (@snpsimd-SLOGE)

116:06 (gnpslmd) (Bsnpslmd-SLOGE) === Host Info ===

:16:06 (znpsimd) (Bsnnslmd-SLOGE) Host used in license file: gwlicsnss

:16:06 (sopslmd) (@snpslmd-SLOGE) Running on Hypervisor: Not determined - treat as Physica]l
:16:06 (snpslmd) (Esnpslmd-SLOGE)

b) & SUF sV A UE SO ) snpsimd #%4%;
c) ftsnpsimd #%& T, BIESIIAT M Imtools.exe, St WK 3-4 fr
No
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3 IR 3.5SynplifyPro License Mz

& 34 SCL B&iR |

LMTOOLS by Flexera Software LLC
File Edit Mode Help

- *

Service/License File ] System Settings ] Ltiities Start

Server Status ] Server Diags | Config Services | Bomowing ]

FlexNet license services installed on this computer

Start Server | Stop Server ReRead License File

- [™ Force Server Shutdown
B i el NOTE: This box must be checked to shut down a license server

when licenses are bomowed.

|Usir|g License File: C:\ProgramData“Mational Instruments'License Manager'Licenses

d) #%# “Config Services” T2, FLEAMXK A, W 3-5 Fik:
“Path to the Imgrd.exe file” : Imgrd.exe S F T E 42
“Path to the license file” : license U FrE K17
“Path to the debug log file” : %k license J& 4 %1 log ST+
MR (357G log SCF, BLE AT — log SXH).
3-5 SCLBEERE

LMTOOLS by Flexera Software LLC
File Edit Mode Help

===

Service/License File | System Settings | Ltilties | Start/Stop/Reread | Server Status | Server Diags  Config Services | Bomrowing |

Configure Service

Save Service
Remove Service

Service Name |NILM License Manager ﬂ

Path to the Imard exe file |C ASynopsystSCL\2018.06'win 32%binmard .ex: M

- —_— - B
Pathtothe licensefie  |C:\Synopsys\SCL'\gowin_Synplfypro_54EE753; rowse

Path to the debug logfile  |C-Symepsys\SCLAmgrd log Browse | View Log... |

[~ Start Server at Power Up Iv Use Services [~ FlexNet Licensing Service Required

The FlexMet Licensing Service is required for optional
features such as virtualization and trusted storage.

e) BLE5E)a, JAshF iR Ss, Wk 3-6 frs, ¥ “ Start/Stop/Reread”
T2, i “Start Server” ,  WJ{E T EI~ “Server Start
Successful” MK BB, WATEISAEE log X E TS E 3l
BT, Al 3-5 ) View Log AJ & F log S04
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3 IR 3.6 fii ik T H License %k

[# 3-6 SCL /3= license R M
LMTOOLS by Flexera Software LLC o] @ =
File Edit Mode Help

Service/Licenze File | System Settings | Utlities ~ Start/Stop/Rersad | Server Status | Server Diags | Config Services | Borowing |

FlesMet license services installed on this computer

Stop Server FeRead Licenze File
i _ [ Farce Server Shutdawn
Edit Advanced selfings MWATE: This box must be checked to shut down a license server

when licenses are borrowed.

|Sewer Start Successful|

¥E!

o EIREUTIERSZ G, FFFREE RS ALE LM_LICENSE_FILE A4 7 %0
# SynplifyPro V3 VFAlHE. 4if 3-7 fios:

e ZE#4: LM_LICENSE_FILE;

o AFHE{H: License XML E, Wl: “27020@192.168.31.33”, H:11“192.168.31.33"
NAHLE) 1P Hidik

B 3-7 FETERE

ERE P

itEne |@r | =% | E5ee a8 |
HEns . 5%

Administrater B PAEE ()

|
sEAATE [S=oc
T m: IM_LICENSE_FILE
TEE V. 27020@192. 168. 31. 33
[ = || Bl |
TH Iz} =
_DFY_THSTALL. .. 1 4
MtiumFath C:\Frogram Files'Altium Dezigne. ..
ComSpec C:'Windowshspstem32hemnd. exe
FF WO _HOST Hn !

(mEw.. | [WEo... | [ #Eo |

[ e J[ muH |

(1

3.6 B2k T B License ME

Gowin =R 22 2 52 g » 371 IR B A B 22 %) License #E4T check,
R License A IEAfN A TCIEFT H -4 1 Error 32754, WK 3-8 Fos.
3-8 License Error 127RE
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3 IR 3.6 fii ik T H License %k

vy Error . &J

./.. & .-\.
[ |
L7

License check failed, please check your settings.

Gowin =R 22552 G TR AL E License (&, 2R UIF:
AEOEEERN

1. #TJF Gowin =¥/ A, 754~ b, #idi “Help> Manage
License...” , #i “License Configuration” %1, #1k 3-9 Fiis.

3-9 Manage License &I}

rw License Configuration @1

License Config

() Use Local License File (@ Use Floating License Server

Server: 192 . 168 . 30 . 40  Port: 10559

Apply for License HAIH License [ Save l l Cancel

b

2. H Pl ikFEAH License LB 5] License SCA:
® Use Local License File
kA node-locked License 4, i “Browse...” , s

FI#E A% o
!

Uik License X 14, ¥.ili “License Configuration” % [0/ R 5 “Apply for License”
i “HiE License” Hiig. “Apply for License” £x#k#4 %95 ) License H i
U, “HG License” 2Bk F|H LI License HIiE DL

SUG100-1.9 15(83)




3 WA A

3.6 fifAAizk T. B License %X

Use Floating License Server
R EFEVFAEARSS, T PnrLicenseServer BF, RIEpE 23
£, F A J2“ GowinLicenseServerForWindows\PnrLicenseServer”,
wlE N PA N A 7 205 3 PnrLicenseServer:
a) HEWNS “gwlic_server.exe” Ja3:
B S RTIE SO (U gowin_license.lic) & 1 )
“GowinLicenseServerForwWindows\PnrLicenseServer”, ¥i¥
A ATIE 4 oy “gowin.lic” , Xdi “gwlic_server.exe” ;
b) #r&ATAE B
B S RTIE SO (i gowin_license.lic) & il )
“GowinLicenseServerForwWindows\PnrLicenseServer”, 7t
cmd % K1 gwlic_server.exe FrfEER4E N i AT
gwlic_server.exe -l gowin_license.lic. /23h/a W& 3-10 fis.

3-10 Gowin Floating License Server BEIAH

B EES: Ch\windows\system32\cmd.exe - gwlic_server.exe -l CB1FE626CIA5 floating.lic

48 >

48 >

o | B |l

loading license...
tool: gowin,., limit: 18, expired date: 2816-85-25

starting server...
Host—-id: C81F6626CT?AS

IP Addres=z: 192.168.31.97
Listening Port: 18559
server started, waiting for connection...

3. JAEIEThZ 5, fE“Licese Configuration” & 14 AR SS 25 11) 1P Hudik,
WA 3-11 Fros.

3-11Floating License B2 & 51

{A# License Configuration

=3

License Config

Uze Local Licenze File @ Vsze Floating Licensze Server

Serwver: 192 . 188 . 30 . 40  Pert: 10559

Apply for Licenze FAJH License

Test Connection

Save | | Cancel

SUG100-1.9
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3 IR 3.7 BAFV AE N (Linux)

4. AN Test Connection #%4H nf LA BE M B R ), BRI & 1E
License Configuration % 1+ H I}l successed, I 3-12 Fiow.

3-12 ik
[ N
WA License Configuration lﬁj
License Config
Use Local License File @ Use Floating Licensze Serwer
Serwver: 192 . 1R8 . 30 . 40 Fort: 10559 Test Conmection
Succeszed
[
Apply for License EAIE License Save ] | Cancel
XHEN

F P el ik A License SCHEEIF3) License SCfF, EZEM = IR #AF
path\IDE\bin H 5~ il & S (gwlicense.ini), K AHh License U
A7 B 5 NER S 21 1P k5 ONEIT], f.

A license X4 [license]lic="D:\Gowin\1.9.2\gowin_license.lic"
7F3) license 3 f4F: [license]lic="192.168.31.97:10559"
3.7 A FRTUEINE (Linux)
3.7.1 SynplifyPro License JiN#Y

Linux 835 K9 SynplifyPro R 45 Floating License 287!, 4 5
SynplifyPro ] License J&, ## license.txt SCHEAEAE Imgrd 842 T, JUCEA
HE B2 TR license.txt I, EEBCR 4550 #6642

Linux %4t (LA 64 fi7 Linux %4;, Redhat 5 i) T 37 ¥ floating license
2R, 1HZH UL NP REPAT IS 2
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3 w2

3.7 B AE D # (Linux)

SUG100-1.9

1B “GowinLicenseServerForLinux\SCL\Synopsysinstaller” F,
4 “installer INSTALL_README.txt” Z3HiR, 2%
“Synopsysinstaller”:

a) ft Synopsysinstaller_v4.1.run SCAEER TS, B SCCHFRUBR AR OR AT LA
i, BT 4247, 1817 “chmod 755
Synopsysinstaller_v4.1.run”,

b) YI#:Z root AR, 7E Synopsysinstaller_v4.1.run 4% N AT 222 iy
AUR: “./Synopsysinstaller_v4.1.run -d /usr/synopsys/installer”.

c) 1BiH root BUPR, iR ART MR, 7S ATEAPAT: “chmod
-R 755 /usr/synopsysl/installer”,

TR INFA AR B

- WHJE Cshell, i17:

“set path=(/usr/synopsys/installer $path)”

- N3 Bourne 5/& Bash shell, Niz47:

“PATH=/usr/synopsys/installer:$PATH”

“export PATH”

d) FILAH“export”f5 4 &M A &, MIHHIA PATH & S

4 “GowinLicenseServerForLinux\SCL\doc” )

“scl_INSTALL_README.txt” #1T SCL #fF 2%, ikt “path/
scl_lic_server_linux/v2018.06":

a) W suse R4, MM “GowinLicenseServerForLinux\SCL” [

“scl_v2018.06_linux64.spf” 3ff, wifZHAh R4 (CentOS,
Redhat, UBUNTU %), NIHE: “scl_v2018.06_suse64.spf” (4.
b) TE%%%Uf Synopsysinstaller 2 J&, %% SCL 3, #UTmm4:
“installer -batch_installer -source <SOURCE> -target <DEST>"
<SOURCE>} spf CHF %1%, <DEST>H4% SCL A1 4% .
LR SRV R R IR R, TR “yes” 4k

A FIE LGRS R license A%

a) EHOTHEALAIK A MAC Hihit
7t floating license (A, % “SERVER hostnamel
000C293B1A2B 27020” 'A% hostnamel BH N R4t 14,
000C293B1A2B 4y HWaddr, 27020 Jyiiti [1-5, #4223 SynplifyPro
NS BT B, . “SERVER gaoyun 000C293B1A2B
270207 ;

b) & snpsimd %42
HRYE SCL # A snpsimd (#5142, ¥ license {441 “VENDOR
snpsimd /path/to/snpsimd™—17, B N4 snpsimd 1245, 0
“VENDOR snpsimd
path/scl_lic_server_linux/v2018.06/linux64/bin/snpsimd”.

i SCL fin#k License: 7t Imgrd 42 F #1795 4“./Imgrd -c license.txt

-llic.log”, A:Hk log 3L liclog, #F lic.log SCAFHHIAE 5 N T, U

n#E s, log XAl an & 3-3 s . Bl 3-4 SCL Ja3h 7t

Pie B MR AT &
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3 IR 3.7 BAFV AE N (Linux)

a) WHENIEAE LM_LICENSE_FILE, H{EMER AN EOS@ EHAZ,
11: setenv LM_LICENSE_FILE 27020@gaoyun.

b) License %3t fErr, ERIAKH 27020 i 1, FH /A 4w%# License #f
e, B R: 17T License S0, #r#k “27020” 745 E, F
HABMCNR .

V!

AKX license HERIEFR LA ARWIT, FrE 182397 license 3t Hx T 4T
e J#k license—— “./Imgrd —c licensefile - lic.log” ;

o {%H] license—— “./Imdown -c licensefile” ;

e 1% license A

3.7.2 ALk LA License INE

Linux *~3% T~ Gowin License I N#IL 2 5 Windows 435 FAH[E], 1HS
2 3.6 A Fifii 2k T. & License k.

“/imstat -a -c A5 @FEHZ” .
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4 ZPREAT T S

R EGH P FE

AP RE W E 4-1 o, EESAPSEE . SRR, THA,
THEHX (Design @), X (Process & ). JESCF4i4E X
FRHHE X (Output),

41 RERPAE

3 ;
. : . . . 1 =) )
s GOWIN FPGA Designer - [D:\lgowin_project\8bit_counter\src\counterl.v] = S
| Hle Edit Project Tools | Window Help ||
L [h = — o B oo
Ok o & Ui
Dezign 5 X 1 // Eight bit counter example 1 -
2
4 Bbit_counter - [D:'ge™ * || 3 module counterl(out?, cout, data, load, cin, clk):
@--— E] G H-LV4S0S4G - (] 2 output [3:0] out2;
4 " i 5 output cout;
Verilog Files || & dinput [3:0] data: =
Frocess 8 x ; input load, cin, clk:
I Design Summary “I| 8 reg [3:0] outl,cut2;
@__ | 4 [} User Constraints )| 10 ~
11 always @ (posedge clk) e
1| FloorPlanner ~|| 12 Opegin @
. 13 if (load)
H. T = X :
B 14 outl = data;
(oass] 15 | erse
; ; 16 outl = outl + cin;
Unit Files 17 il
@ counterl srcycounterl.y 4| 1 3
; Start Page Design Summary ,' cou.nterl.v@ |
Output 5 X
Info (PWODD1) : Power analysis completed. -
@ Info (CMOO08) : Generate 'D:\gowin_project\-%bit_co'_lnteI\irr.pl\pnr\abit_coanter.;l |
Info (CMO008) : Generate 'D:\gowin project\8bit_counter\impl\pnr\8bit_ counter. —
Tnfn (CMOANS8) : Generate '"M:anwin nradecthfhit coonteriimnlionri8hit conter.
< | 11 [
Commi t
| Dutput | Tazues |
In: 22 Col: 12
(o — - —

ot

TREEHX
o AR X
75 X

P Iﬁ:ﬁéiﬂE

@ tx
®
@ witEg%ERIX

Q@@@
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4 VA S 4.1 b

4.1 FREI=

FERR A LR BT ISR

4.2 FEHEE=
F R — e F S DL K TR R A 3 T, A4 File, Edit. Project.
Tools. Window Al Help #&3, 450

1. File 3zsft:
New, Hr& CAFF T2
Open, FTH M TAE;
Save, {RAFLFEH SO
Save As..., XM HHFN;
Save All, {RAFFTA
Close, KM TfEsk#E TR RIS TUH;
Close All, XHFTE S DU
Close Project, <[4/ THE;
Print, FTE[
Recent Files, it H W30, BT LAE AT
Recent Projects, firfTHl ) T2, W] LAEEHrik$E4TIT;
Exit, IR H
2. Edit SEHF:
Undo, J#lH;
Redo, Hfi;
CUt’ _;Evﬁ_[:)],
Copy, Eiil;
Paste, fhillk;
Select All, EHF4EL;
Find, 74 #0C8EA;
Macros, 7.
3. Project SEHF:
® Archive Project, TFf2F]1;
e Restore Archived Project, &8 #3161 T,
® Set Device, WHE I LM device;
[ ]
[ ]

Configuration, T H¢ & Ft1Hl;
Design Summary, 7&&7x 417 TR ARG .
4. Tools SEH .
Start Page, JFiATT;
Synplify Pro, iii4e & 84
Gowin Analyzer Oscilloscope, &z EZZ AT
IP Core Generator, IP Core ;=4 %%;
Programmer, FPGA %ifigs;
FloorPlanner, P25 gk 4%
Timing Constraints Editor, [ 5% 7R 25 2%,
Options, H P AJfEILAL B 44T AR EL ) T R i & IDE 4L,
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4 IRPAT L S

43 THE

5. Window 3 #f .
Full Screen, 45 EIR;
Tile, “F4fifER;
Cascade, & P7n;
Reset Layout, TKEHIIHBLE ;
Panels, X} S H & X B 7R A 1 4% 5
Start Page, {EIFEICF4i#X & Start Page;
Design Summary, & SCAF4wE X 27~ Design Page.
6. Help SEHf:

e View Help, &% B CRY;

e ContactUs, BERIA;

e Manage License, VFrJiEE ,

°

About, BAFIRAME R

43 TEE

F R — S DR PO T In) N 1, FEH A A KR s i S A
5 T (New File or Project). 4TJF3( /5 T.# (Open File or Project). &
Xt (Save). fRAEFTA X (Save AlD. FTED (Print). {44 (Undo)-.
HEff (Redo). BIY) (Cut). Ei#| (Copy). Hilli (Paste). &k (Find).
Synplify Pro. Gowin Analyzer Oscilloscope . IP Core Generator.
Programmer.

14 TEEHRX (Design HO)

T BRI TR R AR S B BN 7R D e, 32 2 o B R P
MEAEE R R Bt 3Cfe . 1P - A AR B A5

4.5 TEEEX (Process HO)

FERMEH P FPGA %1 ifE, fdE45 G (Synthsis) . i il £k (Place
& Route) LLK F# LR SCE (Program Device), [&] 7] XU 4T i FF 4
A2 T B AT A RS Y

4.6 It BEHERX (Hierarchy H[)

SUG100-1.9

IEBeT SO 5, IDE 256X Bt SR #EAT AT, Hierarchy & 4 BoR
AT TR EH R, Unit 5 SR 1% SCH ) module Z20 451, Files
H13% 7~ module 5 SCFTTE ) S

A module & s A B H A BESR R, w DL A s
[¥]”Goto Module Instantiation”#1”Goto Module Definition” & {i. module & X
A module SEFIALAE B S F AL E . 7E Hierarchy & O, 4> module
H S A i 2 Set As Top Module”, #% E A top 1 module <48 intnic

“SE BB module 42 top module, HJE A hierarchy |24t 45 I ANEE .
!

Hierarchy % 1 H A SCHEAT VHDL SCHR T, PRk, an SRtk it & vhdl ST,
IDE 24 ! error, X2 hierarchy & Rk ), BT EWIS.
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4 ZPREAT T S A7 PG X

4.7 B gRiEX

FEALFEAR M S iR S B D RE

7E File & FUBT R EGFT S0 256 J5 A B S LA & Place & Route
Ja A B SO T B R ESCAR B X, Rk “Start Page” K TFEM)
“Design Summary” [FIFE 2 R 7E ARG X .

WISCAF BRI SUARG X N, TR SO 3R T TS S, AR SOA
XN H “File Changed” XHEHE, Wik 4-2 fiion, %4 “Reload”
W2 5 In Az ek
B 4-2 3 ERERRIE
i The file *C:\Users\rooct\Desktop\l SIDE\test\implipnricst. cfg’ changed on disk.
* | Do you want to reload?

iy “File” s HA~ A “Close” MeIiBl SCA G 4 X 2 Fif s SCF 44 4
3, o9 A SCAR SR8 X P 24 TS s £ S0 A

il “File” S5~ “Close All” eI, N 23 5% P SCA G 4 [X N R 7R I
P A

4.8 ERHWHEX

BRI ATE R AIE R, RIS T EF A [F ST )
&’fglgux:

o &R TT (Output 71)

o [1fi{Z E T (lssues )

£ Output & LI A7 58, 1%kF% “Clear” , AJi&EZ i THI{E R Issues
TUAL % Warning A Error B/ F-1E50, A% Issues TLH H 7R warning {5
B error 5, BANTFRITSIEFRIE B IR A1C 5 H B Warning B
¥ Error B9/, 1K 4-3 Fias. {E Issues & A A58, #%4% “Clear”, W
5 2% 2480 0L RE S
B 4-3 (FEMERE

Dlesign Frocess ' Start Page

I==nes

L&

I @A: multi srs_gen output is up to date. No run necessary.

I @A: MF827 |No comnstraint file specified.

I EW: FX474 |User-specified initial wvalue defined for some segquential el
I, BW: MT529% :"d:\gowin projectibsramicnt & léxlk O\srchtop.v":10:0:10:5
I @W: MT420 |Found inferred clock top|clk with period 2.0Zns. Please dec

4

Output Issues

SUG100-1.9 23(83)




4 IRPAT L S 4.8 {5 Btk X

i PnR it (525 Error 8 Warning 15 B J5 #oi ik #% “Help”,
ol R “FL17, 23 %4k Error B Warning 1) “GOWIN Help” #5 1)
RS, SRRV IR 1% 4% Error B Warning F 3 BIE B .
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5 = IR 5.1 Hd T

IR ER

A SR Windows A1 Linux PN RRCA, HLSZ 35 St T AR 2R i 24786
X217, LA Windows JiAs, FEIZAT A, SR8 k.

5.1 FETIiz

1. B “File> New...” , 3TH “New” XHEHE, @WK 5-1 Fix.

B 51 FEIliz
rw MNew l PR )
4 Projects s

iy FPGA Design Project

4 Files

e Verilog File

& VHDL File

|y Physical Constraints File

ey Timing Constraints File -
"

E!
IR @IS DL R = F007 AT I “New” REHE:

o fHJTTRIERE Ctrl+N;

e Hif; T.AF: E“New File or Project” El#x;

e il Start Page %t _I-“Quick Start>New Project”,

2. %&¥ “FPGA Design Project” , #.ii “OK” , #TJf “Project Wizard”

&, i 5-2 fos
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5 IR

5.1 Hd T

& 5-2 HiE TEmS
.
5
s Project Wizard &J
Project MName
E}» Project Hame
) Enter 3 name for your project, and specify = directory where the preject will be stered The directory will be
Select Device created if it dossnt exist
Sunmary
Hame: fpga_project_2
Create in: D:\gowin_projectil. 0.0
[7] Use as default peoject location
Hext >

3. Gl THEAMEESE, WK 5-2 k.
a). fE“Name SCAMEH A TR
b) el PERE TR
"

o BRAAT AT L ERAR WA SR S AT R SO SRR, T DL TR RS AR AN

A7 LA

e  Windows A Linux T SCAF AR BEXIAT IR, fEESAR TAAESCIF R R4

BRAAITEOL T, MHBR B #5 DR AR 0 2 2RI

e 5 Linux A[F, 7£ Windows FEZ5 A “\” , W1 E\Gowin\ide;
e ik “Use as default project location” , Bl 2ki% TR EAE X B BN KT,

N UCH I TRER BN TR B A AR

4. i “Next” , WHE FPGA & HMAS, WK 5-3 W E FPGA B HHLE

PR

® f{F “Select Device” & ik#E “Series” fl “Device” ;

o f{f “Package” NHu#lzR ey,
® {f “Speed” NHiFFK Ik FIH L EN;
°

f£ “Part Number” ik FRANM S, I Hizih Borprik st

Fr PR SRS

SUG100-1.9
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5 IR

5.1 Hd T

SUG100-1.9

[#] 5-3 i E FPGA 7.3)—*.&15

A Project Wizard

Select Device
Froject Hame
Specify a target device for your project

Bl Select Davice

Filter
Sunnary

Series: |GHLN

Part Number Device
| GW1N-LV4PG256C6/15 | GWIN-4
GW1N-UV4PG256C6/15 GWIN-4

v| Device: [hin-4 -]
Package: |PEGAZSS -]
Speed:  [CB/IS ~|
Package Speed \Voltage 10 LuT FF
PBGA256 C6/15 v 207 4608 23456
PBGA256 Co/15 uv 207 4608 3456

5. iy “Next’, £ “Summary” E& T &1 FPGA TREK TS

zu\&‘b‘}fl‘,fcl oy} ﬁl:l 5-4 Fﬁ/j—:\‘ o
E 54 I*E{ﬁll_,\

W Project Wizard -

[55)

Summar y
Project Hame
Project
Mame: fpga_project_2
Directory: D:\gowin_projecti1.9.8

Select Dlevice

EP Summary

Device
Part Number:
Series: GWIN
Device: GWIN-4
Package: PBGAZ5E
Speed: C&/IS

GWIN-LV4PG256CE/I5

Source Directory: D:\gowin_projectil.9.8\fpga_project_2\src
Implementation Directory: D:\gowin_project\l.9.8\fpga_project_2\impl

6. H.ii “Finish” , TIEAIE .
!

PY ,’E;}#B"jﬂ"]

T.7% Device;

o LREFTH MU KA FR SO FAE TRECVE 2 Ja i in, VEAR(E B2

F£>5.3.2 gmf TFE

ST LR 2 F B, H4E BiE5 % 5.3 4t LFE>5.3.1 18

2% 5.3 il L.
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5 = IR 52 {1 TH#E

52 I THIIE
AP Bl AR A mE AT C e ER E s A TR, AL NI
J7 RFTH AR
FE—

1. SR, % “File> Open ...” 417 “Open File” XHEHE, 41/ 5-5
FITR -

vardl |
#E!

JRAE R T RAE R ¢

7 Ekr, FTFF “Open File” HEHE.
55 yTAIRE

{A» Open File Iﬁ.‘
» A | <« FHUEEER (D) » gowin_project » 1.9.0 » fpga projectl » > | ¥+ ||| %= foga project 1 o
- e, o[ =0
EA v ETEE =~ 0O @
v s £ = =3 F
o T impl i
msE L src =
u mEsEes || L fPgaproject Lgpr GPRJ 7% 1KB
. 19
. gowin_project
= E
1 R
SFE(N): fpga_project_1.gpr - [A” Files (*) (*7) ']
[ 70 || =& |

F% “Open File > TR (*.gprp) 7, Hdi “Open” , T LIE,
FEk=
1. ff “Start Page” TiHIH, Hii o= ” . FTH “Open Project” Xfid
HE
2. “Open” , I L.
BE=
e, i “File> Recent Projects” , ik F 4TI THL.
!
e JRAJ{E “Start Page >Recent Projects” 5|, FEFT I TR
“Recent Projects” At il it TFEIZR s

iz TR C MBS, 251 “Open Project” #27-HE, W1 5-6 Fias.

SUG100-1.9
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5 = IR 5.3 ZwiE T2

[ 5-6 TH2MFRiRRIE
(4% Open Project ]
&% Con not open project "Di\gowin project\1.9.0\doc\doc.gprj"
@ zewrmmenme
o]
Pepr

FEABFRBNEE ST (0 TS, AE TR 3B AR F*.gpry, X TRESCF,
iz B s S IREAT T IF LR

5.3 4w LIE
T LR, I/ LRSI FPGA L2 HE B AL
3 T, WA 5-7 Fios.
THEEX FTEGEINMER:
o FPGA THEMBAZER;
o [FHMEHER: SRS, H37f)E,
o M LREEEHXHELR, BFHP &I T, MHE 2R Cest).
P21 S (sde) GAO FLE X (.gao). DhFEsr#r GPA L& S

(.gpa) %,
5-7 TiEXH#EO
Desizn 5 X
A IDE_0S30 — [IIquser—ba]{sters_.-"rootf"'g

&] GW2A-LV18PGE484C8/17
A HOL Files

srcftesty
v Physical Constraints
srcfIDE_0830.cst
v Timing Constraints

src/IDE_0830.sdc
v GACQ Config Files

srcfIDE_0830.gao
v GPA Config Files

srcftest.gpa
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5 = IR 5.3 ZwiE T2

5.3.1 ¥ T#E Device
ETREERXE ATHAELEARE/RYE FPGA LR H IS E

¥

1. WK 57, X “GWIN-LVAPG256C6/I5” , $TJF “Select Device” &
1, Wik 5-8 Fir;

2. {E “Select Device” % I1H1L#E “Series” 1 “Device”, 7t “Package”
T?ﬁﬂ%ﬁlﬂiiﬁﬁ%%@, £ “Speed” THAIRHIEEHEEER, /£
“Part Number” #i&# RS, RIRMESCYHT T H 1) Device

2
ﬁ/%\ o

vE!
“Part Number” #2H1 f27R Biris o i I 41 RS B
% 5-8 T#2E & Device (58

Ay Select Device " M1
Filter
Series: |GHLN v| Devieer  [cHLN-4 -]
Package: |Any -]
Spasd:  [Any |
| Part Number Device Package Speed Voltage IO LUT FF S-SRAM B-f
GWIN-LVALQ144Ca/15 GWIN-4 LOFP144 C6/15 v 119 4608 3436 N/A
GWIN-LVALQ144C5/14 GWIN-4 LOFP144 C5/14 v 119 4608 3456 N/A
GWIN-LVAMG160CE/13 GWI1N-4 MBGA160 Ce/Is v 131 4608 3456 N/A i
GWIN-LVAMG160CS/14 GWIN-4 MBGA160 C3/14 4608 3436 =
EMM@MEIImmummam@ul-m-lwnaunwl
GWIN-LVAPG256C5/14 GWI1N-4 PBGA256 C5/14 4608 3456
GWIN-LV4PG256MCE/15 GWIN-4 PBGA256M C6/15 v 207 4608 3436 N/A
GWIN-LV4PG256MCS/14 GWIN-4 PBEGA256M C5/14 v 207 4608 3456 MN/A
GWIN-UV4QN32C6/15 GWIN-4 QFN32 CG6/15 uv 24 4608 3456 MN/A
GWIN-UV4AQN32C5/14 GWIN-4 QFN32 C5/14 uv 24 4608 3436 N/A i
1 | ([} | +
0K Cancel

5.3.2 feiE T2t

TAEP RIS BAHEH P %1t S0 (Source Files) 2
FOBC B SO Horh, A0 R FE 2 3R S0 (Physical Constraints File ).
I > 29 3 SC {4 (Timing Constraints File), Bt B L5 GAO fic B 14 (GAO
Config File). GPA it & 4 (GPA Config File),

TR E SRS (TS — MR
FRASLH

A28 G0 AT et B8 TR P 7R S
1. EraE TR

a) Wk 5-9 fion, £ TAEEH XS AR T RbrA %R, %5 “New
File...” , ¥THEH 28/ New XHEHE, W& 5-10 Frx.

b) £ 5-10 1, JEFEFHTEAISCIFIA.
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5 =YRKAFAE 5.3 4iiE T2

& 5-9 ARy
Dezign B X
o fpga_project_1 — [Difgowin_projectfl.g.I:I"i"

GWILN-LV4PG256Ce/15

. Mew File...
i Add Files..
[ 5-10 FEXHFE
w New _ M1

4 Files

B veril og File |

L& VHDL File

EE;. Physical Constraints File

L . . .
& Timing Constraints File

EE;. User Flash Initialization File |
|5 GAO Config File
|5 GPA Config File

O OO O

EE;. Memory Initialization File

Create a Verileg HIL file.

©

| ok || Cencal |

@ Fi/" Verilog ¥t 3ot @ HI/* VHDL it scft
3 WHL KR @ LR
() User Flash %tk 1 (® GAO fii B
@ GPA it &t PAT i 2R 0 A S A

Q) SCHERIFRREX

c) W 5-11 firon, LAETE Verilog File ], &9 “Verilog File” fTJF
it Verilog File & 11,
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5 = IR 5.3 ZwiE T2

& 5-11 & Verilog File @

war New Verilog file

Hame: test
Create in: C:\Usershroot'Desktophl. BIDE\test'isre

Add to current project

d) HEXM4, Hidi “OK”.

!

o WEEMHY M, BRINAE “Add to current project”.

o TIEVE SRR X AT IR A S0, R RVE T g
2. HrathoE S

a). & 5-9 fion, 1E LA P X 2 A Rbn A, %3 “New
File:-”, fTHFHr & CF New XFiEHE, #n&l 5-10 fin;

c) 7E5-10 +f, EFEFHEMEE LR, LLH E GPA Config File
i, i “GPA Config File” T8 GPA Config File & 1, 1
K| 5-12 flioR;

d) HraACE SO, Ao HEELE R SO g XFT R 2 A e B A
e LR EE X G I B S, DL IR A F T2 Al & S, 3T
YuiE, Wik 5-13 FioR.

B 5-12 FiEREXHFE
WAy Mew GPA Config File l DS
Hame test|
Create in: C:\Uzers‘root'\Documentszhfpga project 12\zre Browsze, ..
0K || Cancal |
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5 IR

5.3 ZwiE T2

SUG100-1.9

& 5-13 GPA FRE i

General Setting | Rate Setting | Clock Setting

Device

Device: GHLN-LVFGESECH,IS

COMMERCIAL Process: TYPICAL -

Operating Condition:

Environment

Ambient Temperatuwre: 25 000°C 3| ADC-100°C)

[T Custom Theta JA: |25 000'C/Y
Heat Sink
@) Fone (0 Low Profile () Medium Profile (0 High Profile (0) Custom
Air-flow: wFn

Custom Thets SA: 25 000°C/% |

Board Thermal Model
@ Hone Custem Typical
Eoard Temperature: |25.000°C -40°C-100°C )

Custom Theta JE: |25.000°C/ [

Voltage
VEC: 12007 [5] (1 14¥-1 26¥)

VCCX: 3300V |5 (2. 37S¥-2.T25¥ or 3.135Y-3.465Y)

% Start Fage [ @ Design Sunmery

W GPA Config View B |

o I AN Verilog File 5 8F I CFE 4, NI, iR, Wik 5-14 fr

TN
o WML SO AHE TR B AR AE,
o INVSINAIED B SO E TR B AR ALE,
5-14 ERETR

St B RRTCIERIN, Gnkd 5-15 AR
SRR RS B, W 5-16 Fiaw.

\wr New Verilog file

Hame: test

Create in:

Add to current project

File test. v already exists.

C:hUzershrootiDesktopil 8I0EVtesthere

0K || Cancel |

& 5-15 T4 HRICHHE—4

D #dd to current project

File test. cst already exists.

inr New Physical Constraints File ? 2
Hame: test .est -
Create in: D:'gowin projectil. 9. 04vfpga project_lisre

| K || cencaa |
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5 = IR 5.3 ZwiE T2

B 5-16 FLE ST HHME— 1 )
Wy Create File @

File E:/IDEtest/Ide_testftestl/srcftestl.gac already exists.
Do you want to replace it?

8]4 ] [ Cancel

3. WNINLAE S

a) W 5-17 s, A TREHEXEAL, BilEfcG#, EF “Add
Files...” , 4TJF “Select Files” X} 1FHHE;

b) EFELFESCH:, ATEE &R 2 A SO ST, SERGEsInR
Berh A

!

o UNINSCHERS, ik “Add Files...” , WG SCAEAS R TR F I S22k 4T 3
INIE TS T EZSCE R S B TR 3, T TR, Wk 5-18 Firn;

o UN[EWAIN RTL SO AWCSCHES, M2 B ahE TRE SO H DOR Se k4743
%

o WURERIAI U EEAE RTL Wit AN R 21 ST GPA. GAO L& (1,
MTE TR X S —AN 3044328 “Other Files”.

5-17 Design B OAENEA

Desizn g X

v IDE_0530 — [D:/user—bak/Users/roots/
GW2A-1\V18PG484C8/17
b HDL Files
srcftestv
v Physical Constraints

sro/IDE_0830.cst

|1 Mew File...

[ Add Files..
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5 BTN 5.3 %’k Li%
& 5-18 XS HIF TR HRNIE
W Add files R
(2 These files are out of this project’s source directory.
" Do wou want to copy them into the source directory?
Efwaorlk\floorplanneritop3.vm
| e
4. B TR
il 5-19 Frow, wldt DL AT XTI S0
a) X TARE XN B — 3T, 75 g 8 1 SO A B 2 S s AE U SCAT S
X,
b) RS FHREB S, Hidr “Open” .
5-19 TiE X 4migse e
Wy GOWIN FPGA Designer - [Design Summary]
I Fle Edit Project Tools Window Help
Te=ign " X
4 Bbit_counter - [D:\gzowin_project:= I
I GWIN-UVICME4CE/IS P
4 Verilog Files S
__sre\cqunterlv
4 Physical Ep=g I
src\Bk Open With... 2 |
I Open Terminal Here 5
| Open Containing Folder |
I 2 Remove.. Del o]
I File Properties s
Enable C
l Disable
| Hierarchy I Froces — e |
& Add Files...
lUutput
Info (RAMOO0L1) : RAM inferencing
Info (ATCO0001) : Adder tree reduction
| Info (ATCO002) : Rebuild ALU instances from
!
e EFF “Open With>Add External Editor” , RISl ik B oM gmigss & 0, Wik 5-20
Fizw, PR AR B S 48 SIS I A G 4 2 5
e ik# “Open Containing Folder” W FT JF A4 FT A 1 ST
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5 = IR 5.3 ZwiE T2

e k¥ “Open Terminal Here” w4 H#n&4Tia47 & 11, H 7 aldid ey 2470 1T
o F P E F AR AR CAAE o IR A g iR X 3T A U B ORI 2 )5, Gowin =
TR A2 TR SO AR T S, Wil 5-21
F P % R SR e RARAF R SCHE, IR 250 TR SO R A8 S0, ] 5-22 iR .

lﬁ 5-20 5 BB AR AR
W Options &Jj
External Editor
}i Environment External Editor
— D Always Use External Editor
== Text Editor
Name Program Arguments Add
, External Editor - "
[ notepad++ :D;/Program Files/Notepa.... %f Eemowve
(_:' Synplify Pro Walke Default
[#]items request restart program 0K ] [ Cancel ] [ Apply
=1 \
E 5-21 TIEXHEERA
] The file “C:\UsersircotiDesktopil.  8IDE\testisrcitest. ¥ changed on disk.
. & + Do you want to reload?
:
=1 .
[ 5-22 TIEXHRFIBA

[ Wy Save Iﬁ1

I Save changes to "DM\gowin_project\1.9.0\fpga_project_1\srcitestv” 7
L

| oKk || Discard || Cancel

e

5. MR TAE
a) &P TR T X N I S0
b) bR AHE, %P “Remove” BN E %A “Delete” H#, #iH
“Delete File” X[&HE, 4] 5-23 flizn . £ikH “Delete Permanently”
SIRHE, ZSCHE AT TREMIBR HAERER BB, S0, %30
MAHT TAEMIBR o
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B 5-23 XA MERTEHIA
r“; Delete Files l @ &1

Do wou want to remowe these files:

Diuser-bak\Users\root\Desktop' 1.8.11DE\IDE0706\src\IDEO706.cst

[F] Delete Permanently Cencel
!
TR 2 AL T g X B SO, B i SO R A, W] 5-24 s
[ 5-24 3CH-MHBRIEEA

K It
1 The file 'C:\Usersiroot\Desktopil 8IDE\testisrcitest. ¥ has been remowed on disk.
# . Do you =till want to keep 1t7

6. &HE LEXMHENME
FE TR BN AR — SO b sl RO A B, e B S PR 21 36 LI

File Properties, £t i% 30 130 A R M HFHE, 1 5-245 FiR. AHFHE

W% SR AR (S B BB )L & 75 Enable. Type LA Library 15 ..

I Type T i 4240 v LU B SO ) type (58, miidi OK J&, %3

fF2=1£ Design & I H3h#2 ) B Pk type KA T

E 525 TIEXHERY

r% File Properties [ 2 -53-]1

Fath: D:fgowin_project/8bit_counter/srefcounterl. «

Modified: 2019-053-15 13:33:21

Enable: @ True () False

Type: Yerilog -

Library: work

0K ] [ Cancel
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7. TFECfER) Enable/Disable Tk

E TR X N IMTE— SO e A B, 90 IR TAE R B Enable A1

Disable #3, #1& 5-19 fiz~. Enable / Disable % & J5, Synthesize

o} Place & Route REfEIERELEL enable SCAHI N % .

a) A EESE kI B ) Enable / Disable (45 b Sz {41 %
BRIt E R ED;

b) % ZAN %1 (HDL Files % Netlist Files) i, Enable #iI Disable
HB H 5

c) AT [A—Fh Ly s ISR L B 2R SO, i 2 ANE), Enable ATTH,
Disable "] H, 4n&l 5-26 fi7s;

d) XFR-—FARE sk ER M, TRPYRE AT
Enable K%, FHUCHEBININE, 2265 — 29 S BAC B
Disable #7; 4i&H £ ANAFEZRBF SRS, Enable £ Disable D
ANATH, il 5-27 Fis.

[ 5-26 & B A E KRB H A RIER

Tesizn B x| 1

a fpga_project_1 = [D:/gowin_projes
['2] GWIN-LVAPG256C6,/15
4 HOL Files
srcftestw
src/topw
4 Physical Constraints
X
src/fpga_project_2.cst
Ll Timing Constraints

X

src/fpag_project_3.sdc

Y

Open
Open With... »

4 Open Terminal Here

Open Containing Folder
24 Remove.. Del
Disable

New File...

¢ Add Files...

5-27 i P BN T RIRB A RIEE

Design g X |1

fpga_project_l = [D:fgowin_proje
&] GWIN-LV4PG256CE/15
HDL Files
sroftestar
srcftop.v
Physical Constraints

R F—
4 Open
19 2
Open With... 3

Open Terminal Here

Al Bl

Open Containing Folder
) Remove... Del

New File...
(L& Add Files...
src/fooa proiect Lopa Tl
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5.3.3 B TIEM &
fE LAREHX A 1) Synthesize 4bEk Place & Route 4b, Hifi BUbn 45 5
iEF “Configuration” , T+ TR E @MU, W 5-28 Fiw.

5-28 TR ERE
'“} Configurations - Iéj.‘
Synthesize
4 Synthesize General_ . . .
E— Synthesis Toel: @ Synplify Pro ) GowinSynthesis
4 Place & Route Top Module/Entity:
General Include Fath: L)
Dual-Purpose Pin Synplify Fro
BitStream Category: |All -
Label Value it
Frequency Auto =
Use Clock Period for Unconstrainted 10 False
Fanout Guide 10000
Disable I/O Insertion False
Update Compile Point Timing Data False
Read Write Check on RAM True
Annotated Properties for Analyst True i
0K ] [ ] ] [ Apply

WK 5-28 fis, AIACE R TREEHEE S Synthesize J& 441 Place &
Route J& 1%, Place & Route J& £ X 4% General J§ 4. Dual-Purpose Pin
JEPE LK BitStream Jg& 14 :

e Synthesize: A THCE %4 T EMLH Wi BT &S50 1%

e General: HTH BT RAMLRN FISEE R

e Dual-Purpose Pin: FTHCE fri%k Device {5 5 hd2E 77 06 BT 110 15
B, FEHTEESE RS,

e BitStream: H TECE 74 BitStream X215 41 CRC KK . £
JE 45 DA R 3R L
A RAECE SN TR BT

Synthesize

THEMCE S i, 1%+ Synthesize JEVETL. 7E General F%5TN, 7 LLi%
# Synthesis Tool: Synplify Pro 5# GowinSynthesis.
R EFR ) Synthesis Tool y Synplify Pro:
e [ LI4EE Top Module/Entity 1 Include Path 4%
e f{f “Category” THFIERTERBESHICE LRI, BN “ALL” ;
e {f “Lable” ¥|ERHFIEHFFIENZHAFR, “Configuration” & I JEHE
VAT A W=RI i
o XA EZHN “Value” H, WRIEFHFRKECE, & “Apply” , #f
AT EA R, JFTREicE; #if “OK” , SERUAEA .
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I
E!

o XTHHSHEEEM LS X, ESHMZE ASynplifyPro J& it & 487R;
o  CTITERLEMVEMATE, BT 25 ZIR P 1F 235 H 3K SynplifyPro AH2CSCRY,
%42 installPath\SynplifyPro\doc;
e Resetall to default: 4 #i & T AR BINE E, 5 59 H Reset $&7RAE,
W 5-29 Fias.
5-29 Reset IE£7RIE

W Reset @1

Are you sure to reset all options to default?

| ok || cancel |

R %&£ Synthesis Tool & GowinSynthesis, 7] LAiEE Top
Module/Entity. Include Path #4% L )2 Verilog Language . Verilog Language
H=A%k$E: System Verilog 2017. Verilog 2001 #1 Verilog 95.

Place & Route

Place & Route H /] General Iit. & /& & = M7 H B R IAF & = IR
() JE ME T B 0 H , T 7E Value B A5 oUE M, B JE M2 P 5-30 B .

5-30 L Efh &R It 1
g Confguarion: —— ==
Place & Route
4 Synthesize
S— ———
g ‘
4 Place & Route Label Value
General —LGenerate SDF File Ealse
Dual-Purpose Pin ®® Generate Constraint File of Ports False
BitStream @— Generate IBIS File False
@ Generate Post-Place File True
@'—Generate Post-PNR Simulation Model File True
@ Initialize Primitives False
@I— Show All Warnings False
8 Generate Plain Text Timing Report False
@— Run Timing Driven True
@ Use SCF False
@I— Not place register to IOB False
@_ Do mot place register to I0B in implement.
[ ok ][ Cemcel |[ sooly |
@ PRI E SDF X @ 724 Port LSS
® 7= IBIS XfF @ 7= B RSt
® PR A ® S5 E RS R
s P BRI A6 18
@ #HithPrA I Warning 15 5. PR SO R P
A
=
(9 iZ47 Timing Driven T 74 f#iFl SCF ¢
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@ "THHERENFARAR @ B
#F10B I
3!
Reset all to default: 4 HiHic B v 4= Pk 2 BB E .
Dual-Purpose Pin
Dual-Purpose Pin FL &2 & m oo el HE I E, RARE
I H i 5-31 iz .

5-31 L EEREMREY

Dual-Purpose Pin

4 Synthesize [7] Use JTAG as regular I0

General [[] Wse S3PT as regular I0
4 Place & Route [] U=e MSFT as reguler I0
D Uze READY az regular I0

Dual-Purpose Pin [] Uze DOFE as regular IO
BitStream

General

[7] Use RECONFIG_F as regular I0
|:| Uze MOIE az regular IO

0K ] [ Cancel ] [ Apply

!
SHEMNBEMERE D JTAG M JTAGSELN BN H JF x4, B4 ALk IJTAG &t 2R
AL ITAGSELN &, 2471k JITAG &N, NIERA AR ITAGSELN & il .

BitStream

BitStream HC & /& 7 & 00 Fr N 1 bitstream SCAE-# A BL L T #;
PR, HARHECE S Xk 5-32 Fias.
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[ 5-32 BLE LIRS EY
rW Configurations — - - — -

BitStrean

4 Synthesize — V] Ensble CRC Check

General i Enable Compress
4 Place & Route Enable Encryption (only support GHZA)
General

T Key(Hex): |00000000Q -00000000 -00000000 -00000000

Dual-Purpose Pin

; —D Enable Security Bit
BitStream

] Print BSEMM Initial ¥alue
L_| | Background Programming

—| | Secure Mode (dewice can be programmed only oncel

?@%@ﬂf&ﬁﬁ%?

—Download Speed (MHz): |2.500 (default) -
—5FT Flash hddress: O0FFFOO0
[ USERCOIE: @ Default () Custom |00000000
—Bitstream Format: @ Text () Binary
[ o ][ cencal |[ spprly |
=
(@D CRC #5ffifiE @ E4iffiAg
B} Mg (A GW2A) (@ HISTHEE UEY
® wahifibk ® ¥ BSRAM¥JIH1H
5\ bitstream
F
@ T LA
9 TF#Hpix SPI Flash Hitik
@D HI/ e X User Code (DAY
% a
E!

e  SPIFlash #ulit &4~ —¥X multiboot i, %k bitstream AR aA AL, Bk n &%
Gowin Programmer /755,

o AN HTH GWINSE-2C, Ak iZE AN 2 Ha JITAG E I E N GPIO, LT
1 bitStream A4 R BEXT1Z % & 9mFE — IR o

54 =TS

ERREHK, JIH T Rn IR E #P R, i 5-33 fis.
FEZ T 1 ATEAT DL R4
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SUG100-1.9

& Design HEik

J& %)) FloorPlanner;

JA B 7 2 R G i A 5

PAT LG R

BE AR

PAT A AT 28 5

#F Place&Route & 14 R 2

B E = Sk FPGA rfeas 2 Thft .

[ 5-33 T %2 Process B O

Frocess B X

| Design Summary
v [} User Constraints
#| FloorPlanner
% Timing Constraints Editor
¥ T3 Synthesize
Synthesis Report
Metlist File
v Flace & Route
Place & Route Report
Timing Analysis Report
Ports & Pins Report
Power Analysis Report

ul '
i Program Device

Process Desizn Hierarchy
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5.4.1 Design Summary

B TR, Ao b TARE RS 8 B Rt — ik s, Wi
5-34 flis, A =FhJ77%LFT I Design Summary:

e 7£ GOWIN FPGA Designer 5.4~ |, #%# “Window> Design
Summary” ;

® 7t Process &, X “Design Summary” ;

® 7t Process wigH, HdrRARAE, £ “Design Summary” Hik$H
“Open” .

5-34 TIREERER

. Gemw

Project File: D:\gowin_projecty1.9.0\fpga_project_1\fpga_project_1.gprj
Synthesis Tool: SynplifyPro

Target Device

Part Number: GWIN-LV4PG256C6/15
Series; GWIN

Device: GWI1N-4

Package: PBGAZ56

Speed Grade: Ce/ls

Core Voltage: LV

5.4.2 User Constraints
User Constraints $&it 1 BRIEFT A QI L R SR 1. A R R S

WHAWVEMME T, 1E5% Gowin &/ 20K 755
User Constraints 4> FloorPlanner 1 Timing Constriaints Editor.

Y 2) 7R % 45 2% FloorPlanner 13 F 45 5%

1. Xidi“FloorPlanner” s fE 4 8k B FH IR F5“ Run”, Wk TAE MR HAT4R G
M 23 B RHE, WP 5-35 . 228 50 Ja Wi “FloorPlanner’ s /£
AR PIER “Run” BT H YR L R g iE 25

2. L R g, & TP ASHELR S Cest), fwmigass
T B R S A DA G

3. I dmiEds, WIRTREFBEEMIMIEAR M Cest) KAE T, 1R

SRR X AT TS ROHRAES, i FloorPlanner H1ff) reload & |,
ZINME EUE I 20 RSO BB AT e L

4. 5 TREPACEHPARA:, L6 a3 FloorPlanner, 3%
AR A RO R A, W E] 5-36 iR

5. #H LEPAE LR, HFEH R IS TR M2 510

C.est 3P B, Bk MRS B A — 5 TREFEA K2R

A, RBEE T T Warning $275HE, Wi 5-37,
V|
Wik “Tools” 3ZHLH “Floor Planner” il “Timing Constriaints Editor” , 7] E4%
17T Floor Planner I 5 2w &5, M ANZEAT Bt SO 2R B 480
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& 5-35 L TEERTR

Wy Warning @1

Please run Synthesize first,

Aol

L

& 5-36 BIEARHR T .
Wy Constraint File @

This project doesn't include CST file(*.cst), do you want to create a default

one?

oKk || Cancel |

L

[ 5-37 BUBLYSRICH Warning &7 i
W Warning Iﬁ

There is already a default CST file:
4 l L "D:i/gowin_project/1.9.0/fpga_project_1/src/fpga_project_l.cst”, do you
want to override it?

| ok || cancel |

AT 295k 4m%8 8% Timing Constraints Editor fER757%:

1. X“Timing Constraints Editor” s/t 47 S R HIE S “Run” , W5 TAE v R 24T
ZRe, Wit 2o HE, an & 5-35 IR . £5 6 2 Ja Xt “Timing Constraints Editor”
BB IE R “Run” WG24I 52 R Yn 4% 5

2. FTIMAIRgwiRan, & TREPEEN PR (sde) , ZRamE, WMiEsoEH
LTI R A DA G 8

3. AHTLEPACEMBI AR, A5 B QL O R A, Wkl 5-38 fir
7N

4. HITEPACESLRA, BFEH K TEES TRERA KA R (sde 3L
) B, FTIF A 2 M AR S H S A — N5 TR R AR, 2R
B8 55 E ) Warning $27-HE, 11 5-39.

& 5-38 BERFARZAR TR ]

w Constraint File @

This project doesn't include SDC file(*.sdc), do you want to create a
default one?

OK ] ’ Cancel
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B 5-39 BIER AR Warning Hw i
ww Warning Iﬁ

~ There s already a default SDC file:
l “ "Difgowin_project/1.9.0/fpga_project_1/srcffpga_project_l.sdc”, do you
want to override it?

| ok || cancel |

5.4.3 Synthesize

AT Synthesize I RIS PP LE& T H I TE$E, Synplify Pro
A GowinSynthesis, WIRAFITIESE, BUINLRE THZ Synplify Pro.

I AE TR B IX ) Synthesize 4b 90 Bl br 47 B, 1% $“Configuration”,
I A BB B TUE R4 A T, Wl 5-28 k.

Synplify Pro & Synopsys ‘A 1] i 2= 2 AR 1 5@ Hil (10 11 o 5 & 3 AT
SEHE 2 SR B SO R HseBL, S2HF VHDL. Verilog 264 % 15

GowinSynthesis #& i@ = R N Z G A, SCREm 2 - S8R 0 2 S0 S 3
SEEL,  H T SCEF System Verilog #1 Verilog 2005.

Synthesize $efit TIB1T45 A W B S5 E B S EU & H M K S (Netlist
File) flZz&d4d (Synthesis Report) HIThfE.

25 LN IRIZAT Synthesize:

Ko Synthesis J& 1, £5& T.H21%3% Synplify Pro 2{# GowinSynthesis;
£ % Synthesis JBHECE, 1E2% 5.3.3 (B LI HE;

1217 Synthesize;

TEFRE X, Wfi“Synthesize 847 ## *. i “Synthesize> Run”, 53]
Zra THRXNE S AT 255

ELEA T, M Synthesize RABT< LK ¢, BUIHIEE©®

5. ZEAEINE, Ml “Netlist File” SR 104 #IER: Open £, nf&E
WA, HARRPIMER SRS TRAME. 26 TREFR
& Synplify Pro, A HIZRE G MR o vm, #HERE T RIGHR 2
GowinSynthesis, 4R ZEE G RS N*vg.

!

bR

o U4 2T (Synthesize EIREN ) Wik “Netlist File” sk7E %754 4 %4% Open
BRI, WESRHITEE, GERINET MR

o FILEH AT (Synthesize EFR N =y xwak “Synthesis Report” B {E 1% I 45 # %
% Open &, WISSEHATERE, LRa a4 T Eadid .

Fetsdr “Synthesize”, WK 5-40 7] FEAT AR5
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e Run: R Synthesize XaTEIiEN <. Ok ¥ nf, dfiZksis
Ja B erE T RSO AT 27 6

® Rerun: it Synthesize R AR, EFZIET, FHHE 3G
THEXRE AT 27 6

® Stop: {¥1Liz4T Synthesize i F4;

e Clean: JEMRZEA A=A CHFF (synthesize) THIFTH ST M SCHE
Je, miarizik e B RNE, K 5-41 Pk

e Configuration: F X} Synthesis 1 Z¥iE4T % & .

& 5-40 A& d “Synthesize” B

Frocess ® X

| Design Summary
v [2 User Constraints
#| FloorPlanner

% Timing Constraints Editor

viG -

Run
* FRerun
B Stop

Clean

- Configuration
Ports & Pins Report
Power Analysis Report

u .
4 Program Device

E 5-41 £#EE L “Clean” E/R
rv;r Clean Result &r

Do you want to remove this dir:
l % Di\gowin_project)8bit_counter\impl\gwsynthesis

OK ] [ Cancel

b

5.4.4 Place & Route

Place & Route R ILIE1TAR AL 1B B AR a4 26 S50 5 BRAT Jey A 4k
J& LR O DI RE
E!
Place & Route fk#i T 45 &l #2, PATZLIRES, WK (Synthesize) KT, Mi<
AT Synthesize, FHATIZE T,

%25 LT A IRIZ4T Place & Route:
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fic & Place & Route J&t;

KT Place & Route JEMALE, &% 5.3.3 1B TFEALE ;

1217 Place & Route;

X it“Place & Route” B .7 b4t “Place & Route>Run” #4774

AR 2 A bit WSO A SRR & SCF . anisT Ay, Il Place & Route

FART S LB bR, 750 B AR @

5. Place & Route 1T /IJ5, £ Place & Route '~ J5 X ili SO B A ik £
“Open” A 1E LA G B8 DX Wk 2 S

6. FEALERWIUM I, A Place & Route Report. Timing Analysis

Report. Ports & Pins Report & Power Analysis Report, X JUFhsz{43)

ANTT G

!

o B UHTDAITIFRE L, FIET Place & Route THi AR SCAF IR SHRAA T
B SCA

e  #7iZ4T Place & Route Z fiif (Place & Route &bz ), Wkl sh ok life
RS SR BEE SR “Open” &I, W2x%5i21T Place & Route, 1a47 54T
VAR (4=

1188 #.; Place & Route, A THIE/ER S :

e Run: Jf Place & Route Rk | 5t @@ wf, mepizmmis
iz4T Place & Route;

® Rerun: it Place & Route /i FUIRA, E#EZIET, HEHFs1T Place
& Route;

e Stop: {51-iZ1T Place & Route i F£;

e Clean: J&E[:ig1T Place & Route =443 (pnr) FHIATA S K
AETE, T IS P RO AE

e Configuration: AJ%} Place & Route Z¥i T4 & .

PwbdPR

5.4.5 Program Device

SUG100-1.9

DIRAAEAT AT BT T e, SRRSO (s 30fb), &
A a T FPGA Jwfedy, A nli burmi e F#EES . S P TR
T RE -
Ve
Program Device ##§i T- Synthesize /% Place & Route 38, HUATIZAH RN, a0 H AR5
(Synthesize X Place & Route) K#4T, Ll E4ER, WK 5-42 Bk,
5-42 A% Program Device 512w

W Warning I&1

Bitstream file does not exists.

l"-.

M “Program Device” ENfEiZIiA#EHd “Run” &, &=k
Sk FPGA gmfi#s, WKl 5-43 Aiin.
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!

Linux 22& 40 () 4w F2 8835 A T Linux iR 4 Red Hat 5.10, {17 Red Hat 6/7 fRAS (140 2 45 »

HEIEM ET# S, KRBy Gowin = YR 2 e A b g so ok
“Programmer”

[¥] 543 Programmer & H

% Programmer 2 = | B ||
File Edit About

Qs —~

Enable Family Device Operation File Checksum User Code
1 GWIN GWIN-4 SRAM Program D:/gowin_project/1.9.0/fpga_project_1/impl... 0112 00000112

Output F X

HRE SR FPGA fmfEas ) EgnfE H 51k, 5% _(Gowin
Programmer /# / 755 ).

5.5 TIZ4T R mE
IDE SCREXS T TAEEATFT R LA SR B AT B T . I S g
Project H ] “ Archive Project” 1 Restore Archived Project X} T. #2347
FIALEKE .

55.1 T8
F S B Project HH “Archive Project” £x3 H 4T TREXTIEHE, 40
K| 5-44 7R .
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“Archive File Name” TG4, BOAN:Y AT EA4T W T4

—3, JE4iE.gar #.

e “Create In” NTH 5 KIS EAFTUN R4S, BRIV AT THEERAS .

o TH TFETILHE Project source files(ER L 2)i% ) . GowinSynthesis files.
SynplifyPro files. PnR files. Programming files,

o AL TR AATEITIENS, T 772 Boniz e il TR T ks
FIERE AR LA SR/

e Add 1 Remove 41 v] LI Sk B AT G M T €0 1) S04

e i Archive J5, WIR TR EISCHARIRAR, Wi B SRR, 52
INSEORAE A

o TH MG IRE I, IRARTERIIERM, WK 5-45 s,

o ITHTEMJGIE “Create In” B2 T &AE MM TR T E*gar f15

gar [F] 4 BT L+ .garlog. JE43A gar XA R 4a Al B B 48 T L

A, HES*.garlog 2 FALH, W] A B WREL SO T AL DL AT A

iy eI
5-44 TIRITEAE
W Archive Project (-5 |3l
frchive File Hame: &bit_counter gar ¥
Create In: I/ zowin_project/Ehit_counter [ ]
File Types

| Project source files
GowinSyntheszizs files
SyoplifvFro files
PrR files

Programming files

File=
ndd Remove
MNarme Size(KB)
src\Bbit_countercst 0
src\counterl.w 1
Total Files: 2 Total Size: 1 KB
#rchive l | Cancel

5-45 T ERINRR ]
W Archive Project @

'.6.' Archive Project success,

55.2 IRE#HITEIIE

B SE AR Project 1) “Restore Archived Project” >3 K Z 44T
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AL CFEXTUEHME, ] 5-46 Fon.
l§|'5-46 REITETERE

Archived File:

W Restore Archived Project @
)
(B

Destination Folder:

| 0K || Cemeel |

sl “Archived File” AT IR BAZH, TR T T
WRREIRE AT RS, “Destination Folder” 23 H 2l 58 37 #0344 Fir
TERIESAE . st OK Ja 2 #H R ) R ATE .

5.6 IR B

i DL 77 2UR Y IDE:
1. 5 “File > Exit” &,
2. HBBAFEA EAERE e,
!
o EARMRAEMSCME, W Jadrm & 150 ST AT R AT
o IDE#RHEMIRTE (Save). fRAFHT (Save AlD FF 470 (Save As...) Hifig A
BEXT SUR G 4B S IR AT
e IDE X T TR #E (Configuration) {5 2 & L al Xt THE S B3 I 4 AN 2
BB ORA7 2 TAERCE SO, 78 IDE X IR B 3 R A7
o WRHMFIEIEITH, vhEd SR Y IDE.
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67—:71%7&#%}5&:&

6.1 Synplify Pro

Synplify Pro /& Synopsys ‘A 7l Nz - SR L 171 € il (1) i o 28 -6 A
SRR R AR SO LG, SCRF VHDL, Verilog 55 9mA51E 5

%F Synplify Pro [ VE401E S M E1E 15 5% Synplify Pro 44 5“Help
[T ZE I T R

6.2 FloorPlanner

Gowin FloorPlanner & /& > R 17 i 37 5 R 1940 J/ S B2 R
iR T H, Y /0. Primitive (JEi%). block (fZfiffE, DSP). Group
LB YE R AL BAS B S B ThAg,  [RI nl AR (0 AR BRI AR
R SRS, SCHFHELE T 10 MEMEE R, B, BERAEE B,
Gowin FloorPlanner $2t 1 & s R EE 145 R 5 4 R dwik Thae, nSZkrmof
SRR &3k FPGA 85 7% 5o

Ja % FloorPlanner W Fh 7 2

1. KRB FGPA LFERT, A EHIZEHSERAN “Tools” Fhidk dik#
“FloorPlanner” , Iy, FE3@id File>new Nk W& ML oSk & il 3
MEE;

2. L FPGA THER, BE#E{EdFEEHXIZ1T Synthesize Ji& Xl
“FloorPlanner” , I}, FloorPlanner <> BH3EMN# TR SO I SR 7E
FloorPlanner 5tifi

FloorPlanner 43> Chip Array 11 Package View P/~ 1, 40

Kl 6-1 f1E 6-2 i, 1% L EMVEANE 7152 %  (Gowin #1129
EF ). BRIz 4 FloorPlanner i& i LLiEAT IS FEARAL
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6 =IRBIER TR 6.3 I FAH 4%+ (Timing Constraints Editor)

& 6-1 Chip Array B
WA FloorPlanner -

Fle Tool View Help
v L =

Fetlist 8% nip bry @ | Fackage Vi [

4 [B counterl
Ports(13)
Primitives(14)
Nets(39)
Module
Timing Paths

n

Froject | Netlist

Meszage g x

> Info (FPOO0L): Eeading device GF1N-4 package PEGAZSE partnumber GWIN-UV4PGEZSECE/IS

> Info (PADOOLY © “D:fgowin_project/Bbit_counter/Ebit_counter/impl/gwsynthesis/Bbit_counter. vg* | Reading netlist file.

> Info (FADOO4) © Parsing metlist file "D gowin project/Sbit_counter/8bit_counter/inpl/gwsynthesis/Bbit_counter. wg' completed,
> Info (PADOCE) : Processing metlist completed.

> Info (CTOO0Z) © FPhysical Comstraint parsed completed

Me | I/0 Com | Primitivs Com | Group Cows | Resourcs Res~ | Clock Aw | Huadvant Conss | Helk Com | VWref Come

6-2 Package View B[

¥ FloorPlanner ===

File Tool View Help
Y =g

Hetlist
4 3 counterl ; - a3 0 P : A
+ [ Ports(12)
. [ Primitives(14) o000 E
[ Nets(39) o 000G DO C +
» [ Module S oS el e
[ Timing Paths @00 P06 XKoo
200 D006 ® 00
200006 DO I
20000 C 2eeee s
00006 o006 s |
200000 JEIEICKENE r
200006 2eeee s
20006 20606 e e e
2006 00606060 2 e
00 000000 © e 0
0 O 00000000 O
o 000000000000 >
G 0000000 O0
6 9 10 6 i
Project | Hetlist d 0 g

Meszags & x

> Info (FPOOO0L): Reading dewice GW1F-4 package FEGAZSE partnumber GHIN-UVAPGZSECE/IS

> Info  (PADOOLY : “D:fgowin_project/@bit_counter/Gbit_comnter/impl/gwsynthesis/8bit_counter vg” | Reading netlist file

> Info (FADOD4) © Parsing netlizt file "Difgowin troject/Sbit_counter /8bit_counter/implfwspnthesi=/Bbit_counter. vz’ completed
> Info  (PADOOB) : Processing metlist completed

> Info  (CTOD0Z) : Physical Comstraint parsed completed

Wer | 170 Com | Primitive Cow~ | Group Com- Resource Res Clock ke | GQuadvant Cor Helk Cor- Vref Comsr |

6.3 FIF AR 4EEE (Timing Constraints Editor)

mo N FA R 4SS (Timing Constraints Editor) 2 &z 2 S 7 T
W E BRI PR g TR, SCR 2 TR a2 HdniE, e
2R BNE LR B AR L R A R 5SS L R Yn . Timing Constraints
Editor 2 (it 1 ] L ARTERIN P LR i DhRE, 1] SCHF A o SR % FPGA
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6 = IR HF AR T A 6.41P Core f“4:#% (IP Core Generator)

TS}%‘FF&:&] o
J& 5l Timing Constraints Editor 1) 77 375 /5 -

1. WARES FGPA TE, fEHf=r, 1E4% “Tools>Timing Constraints
Editor” , Ubi, TFEIEL File>new Jn#k M #& SC4;

2. W #S FPGA e, fEidfEE H X217 Synthesize 5, X “Timing
Constraints Editor” , ] Timing Constraints Editor <= B 22 %% T 1
It & 7~7E Timing Constraints Editor %1, 1 6-3 fizw.

A RN P A R IR AR I TEARE T U7k, 1§27 _(Gowin &7/ 29 K75 )

& 6-3 Bl R A E
A Gowin Timing Constraints Editor - Ci/Usersfroot/Documents/fpga_project_12/src/fpga_praject_12.sdc S
Fle Constraints Reports View Help
=)
ot
Fetlist Tree & X |Timing Constraints Clock Name Type Period Frequency Rise Fall Divide by
e ) | Clocks [kl . Base 10ns 100MHz 0 5
— Clock Latency I ¢
4 Y test Clock Uncertainty
Ports (6) Clock Group
Nets (14) 1/O Delay
Primitives (11) 4 Path
False Path

Max/Min Delay
Multicycle Path
4 Report

Report Timing
Report High Fanout Nets
Report Route Congestion
Report Min Pulse Width
Report Max Frequency
Report Exception

Set Operating Conditions

Conzole

create_clock —name clkl -period 10 -waveform {0 5} [get_ports {dini[1]}]

6.4 IP Core fF*42& (IP Core Generator)
IP Core Generator LA 2 T/ A LML i = s AL DL s =
KAGH P, @ T R4 et it 2 G, B al i 2 Sl 4 A B s B
BT ThRE . B ET IP Core Generator 845 J5 15 4H ¢ 1 Module &4 F12
W FHIEH) IP Core AN KRALRES 7, W 6-4 s
I8 S A R Tools T hi%1#EH “IP Core Generator” JA3)) IP
Core Generator L. ., #47 IP .

HAREEA 1P B 7575, 16 275 30 (Gowin IP £ T A/ #5775 ).
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6 =IRBIER TR 6.5 m & ELL I M1 (Gowin Analyzer Oscilloscope)

& 6-4 IP Core Generator FH

Target Device: |  GHIN-UV4PGZSBCA/TS | D

MName

4 Hard Module
BandGap
CLOCK
DSp
13C
Memory
SPMI
User Flash
4 Soft IP Core
CAN
CsC
DDRx
FIFO
HyperRAM
12C
I3C
MIPI
Math
Microprocessor System
PSRAM
RAM Based Shift Register
SDRAM Contraller
SPDIF
SPI
Scaler
Triple Speed Ethernet MAC
UART

!
B K () Hard Module 553 Soft IP Core 4471 device FT A 1.

6.5 B LEZIZE I (Gowin Analyzer Oscilloscope)

B ELZE NI (GAO) & E= T H B RN — B F =50
LR, BERHBA T MEE SIS S RN R, PRl
1T RGO TR E A, St R

GAO {135 Gowin GAO it & 1 Gowin Analyzer Oscilloscope H ™ L E..
Gowin GAO it & ¥ Z A T e 5 S B B Wi, X s 8 B
TRFER B, filk Boofilk 1550 Gowin Analyzer Oscilloscope jdiist
JTAG #: SR B AR, K Gowin Core Inserter % & RS 51
HH B T R ok

JA5) GAO Z /i, Tt LAEEMHXHE GAO it & X (.gao), FTHAL
B, K 6-5 Aras.
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6 =IRBIER TR 6.6GPA I3t/ #1 T. B (Gowin Power Analyzer)

& 6-5 GAO it ERH

Triggu ne | Copture Dptisns

...........

nnnnnnn

BLE XML JE, fEgsf=d, &4 “Tools > Gowin Analyzer
Oscilloscope, {THE = FEAELEH AT H, & 6-6 Fix.
6-6 GAO R

Gowin Analyzer Oscillescope

Cable: |Farallel Fort (LET) ~ Y,

o [ [ |

Capture

Sterage Size: 1024 Window Nunber Capture dmount: (1084 v]  Trigger Positiom: 0

Trigger Expressions

expl: MO
Match Unit
Match Unit ~ Trigger Port  Match Type Function Counter Value
MO Trigger 0 Basic == Disabled 0

FELZ AR AT A B BE EAVE VAT 275 _(GOWIN A=26:2° 48 77 Bir (KM
Va1

6.6 GPA IhFE 7 LR (Gowin Power Analyzer)

R T TR (GPA) N PRI AT REMERA I DI FE i, 1R 0 T
FEE T BRI, P RIARYE LR s AT AT O B, i B it
ISERRAE L, 1z DRGSR AR AL 1) DA 3 by 4 SR A v

HET, GPA THNEZNE Jakt DU ERCE T (.gpa) J2Edil, 25 HRAn
FHIR:

SUG100-1.9
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6 ZIRFAF AR T A

6.7 PAF AU S 9 45

1. fERMGLIAEEHEKX (Design), #ii “File>New...” , FFF “New” Xf
THHE;

2. i%&F “GPA Config File” , fESHIIE 1HIHS “Name”;

3. Hud “OK” , HIHYE “Design” & K& F# & ) GPA Config File;

4, Wb, RS EX SR “GPA Config View” BIRTECE, 41l
6-7 .

E 67 GPAELER M|

General Setting | Rate Setting I Clock Setting

Device

Device: GH1H-1-QFF45-6

Operating Condition: COMMERCIAL - Process: TYFICAL -

Enviromnment
Ambient Temperature: 25 000°C 2| (-40°C-100°C)
[[] Custom Theta Jh: |25 000°C/% [
Heat Sink
@ Home () Low Profile () Medium Profile () High Profile () Custom
Air—flow: (LFM)

Custom Theta SA: |25 000°C/% |

Board Thermal Model
@ Home Custom Typical
Board Temperature: |25. 0007 S| -40C-100C)

Custom Theta JE: |25 000°C/% |5

Voltage
VOO 1140V 5 (1. 14¥-1.28¥)

VOCX: 2,500V 5| (2.5¥-3.3¥)

[ Start Page | G GPA Config View B |

AR IFE T THRMBCEAE 7%, 5275 _(Gowin L)#t 74 1A/
S 15 )

6.7 SRIFMERR VIR I i e

SUG100-1.9

HAF g SV aR A SCAE R — A ASCI SO, Hy B4 h.mis FH P aiRIEE
ST ER, AR A A SR AE SO, F DAY B 76 A TP AN HuEE T i
WIUGAE -

B AT SRR A SR ) S 44 9% mi(file_name.mi), SO —1T0%
— MG TT, ATECRD A BT AN B AR A i A8 I LR B Address
Depth; FIEARKBANFAE R ICHE /040, RIS % FE Data Width.
kb A BB SR GEE, BATEE SRR, (RATESG

[P e e A/ U Ao - S W o = 1] N R 1| IR 54 194 e A =2 111 -
X, mi AR B FI R
—i##I#3 (Bin File)

Bin SCAFE B kI E O AT 1 AL SCARSCE, AT EURER AL Ak 28 A Mk
R, FIBURERAF s 5 s 58 5 .
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6.7 PAF AU S 9 45

SUG100-1.9

#File_format=Bin

#Address_depth=16

#Data_width=32
00001100000100000000100100010000
10000000010010000100000001000000
01000000100000001000000010000000
00100000100001001100000011000000
00000100000001000000010000000100
01000010001010100000101000001010
00100010010001000000010001000110
01000101000001110000010101000001
01100100001001001000010000100100
01001001010010010010100101001001
01100101001001010000010100100101
11000001101001010000010110100101
01001000100010000010110000001100
10000101001011010100110100101101
01101100001100110000011100011001
00001001001010010100000110010000

7~iEFIRER, (Hex File)

Hex U115 Bin SCHAR EIRAL,  H1-+oN b3 O~F Lk, A7 8UCRAF %

#File_format=Hex
#Address_depth=8
#Data_width=16
3A40

A28E

0B52

1C49

D602

0801

03E6

4C18

bttt 75i#HIRE T, (Address-Hex File)

SHOHINEIRE, AT B R AR, AR S R B T

Address-Hex U A AE SO A7 A 10 5k ok A&l ARt 4710 5%
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6.7 PAF AU S 9 45

SUG100-1.9

ML ANHCHE #E HhFoSHE L O~F ik, BFATTHE SRTHEMEE, B9 /51H
SR, SO RS NEE I R R AT IR S, A IR S BRI
BEN 0,

#File_format=AddrHex
#Address_depth=256
#Data_width=16
9:FFFF

23:00E0

2a:001F

30:1E00

15128 AT A A AR A SO (K 2 DURT R G EL S AE Cmid D95k, 46

ST g A BARGE D BRI R

1.

2.

3.

FERAE TS FIX (Design), #id “File> New...” , #17F “New” &
s
e “Memory Initiazation File”, 1P 6-8 s iy “OK”, fEFH K

New File $&/~HE B YIIG N AT 47 )5 i “OK”, Wil 6-9 Fk:
Ja S 6-10 Fs IR G A SO L B ST, ST ZC (35S 4 RAK RS VI Uh
B, A 43 e B UG A ST R/ A B A =X

E TG B S A TC B 14640 S 1 Depth AT Width, DL 72 il 4% H

Hi kARG AR ) EUE o g 2.

e Depth 1 Width Z 5 F £ IP Core Generator %[ _E fri% % Block
Memory 5 Shadow Memory ] Address Depth /% Data Width —%,
LIS Address Depth B, Data Width K 541 b ATk £ 1
{H, 1P Core Generator ¥4 &1 /n i iR 15 5 ; % Address Depth 5§ Data
Width /T8 H FH_ERTE £ RE, NIRRT € rhk T~ KE BRI
oA 0, wESEMATE “Update”;

L Sk 11 e S | 7 A (2 N IOV s Wl v 2 i 1 P A | P v
12 VA =i 1]

PGB S 2 R A AT HIBAE R S N, R AME 2 A% HmT UG

FHE B EIE FEAT W E

o HIERLAHWLIRENHAE R, A 1.8, 16 — Ak, WK 6-11
FITR s

o Rk IaaE RERT Ll i Xt 5 Fah 5 N, AT DL A i AT %
B, EEHABEAA AR, %5 “Fill with 0” JZHEVI4EME N 0, “Fill
with 17 480 IEERAIH 9 1, “Custom Fill” {8 2 7] LA 3 75 2
BATHES N, FFERTHEE R BYIGE K 6-12 Fix.

RAE A
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& 6-8 #IRWTHHETIE New 12RHE

w New —
= . ' . -
Eﬂ Physical Constraints File
= 1 v v ]
Eﬂ Timing Constraints File
= o . v ]
Eﬂ User Flash Initialization File =
= ]
Eﬂ GAQ Config File
T . =
Eﬂ GPA Config File 3
"
Memory Initialization File
=
Create memory initialization file.
| ok || Cancal
. a—
B 6-9 MR HITHFIE New File RRHE
i ? B
&y New File uﬂ
Hame: test mi hd
Create in: C:'Uszersroot'Desktopil.SIDE\test'sre
0K || Cancel |
%] %
6-10 B HELE A/ E
. DA\gowinTask\testIDE\gpri\fpga_project f\src\testtmi = =E]r=]
+0 1 +2 +3 +4 SA He
00000000 00 00 il il 00 00 File Format: |Bin -
00001000 0O oo 0o 0o oo oo Depth: 256 =
00010000 00 00 00 00 00 00 width:
00011000 00 00 0o 0o 00 00 Update
00100000 00 oo 0o 0o oo oo View
00101000 00 00 0o 0o 00 00 Address Base: |6in hd
Value Base: Hex -
00110000 00 oo oo oo oo oo
00111000 00 oo oo oo oo oo
01000000 00 oo oo oo oo oo
01001000 00 oo oo oo oo oo
01010000 00 oo oo oo oo oo
01011000 00 oo oo oo oo oo
01100000 00 oo oo oo oo oo
01101000 00 oo oo oo oo oo
01110000 00 oo 0o 0o oo oo
01111000 00 oo 0o 0o oo oo
10000000 00 oo 0o 0o oo oo
10001000 00 oo 0o 0o oo oo
10010000 00 oo 0o 0o oo oo
10011000 00 oo 0o 0o oo oo v
< >
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& 6-11 FI¥ECE

00000000 00 oo oo oo oo 0o 0o

00001000 00 a0 oo i) a0 oo oo

01001000 00 an an an an an an a0

SUG100-1.9 61(83)




7 R T  SES 7.1 A A Eedh it

7§i},§$ﬁ1¢$ﬁl 348

M a nIRAEE FPGA Bt FErp, BRAE ARSI LASE, TR nlis it
HHARREIT 28, ATAEREZA Gowin BRI E A 2%, Bl
JR R AT AT LA i i BRSO I P A DA A 5 55
teah, F P RE A B Place & Route, 182U B R VA= il IR 2 ST
s PR SO

7.1 R ERE

fi AT RS, FIH TR P B S RGO R R B NAETHAEE R
BBV REAS B2, HER P TSGR/ S Bt e B ULEE SN 2
AR A rpt.html, B ARG BRI & E > rpt.html 3CAF-.

FH P AT 7E S AR 45 TR [X 1) Place & Route [X, #i7 “Place & Route
Report” , FTHf FPGA T X} M A A 2k ik i, Wikl 7-1 Fiow o
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7 R T  SES

7.2 ¥ I

JE AR

[ 7-1 Place&Route Report

7.2

A GOWIN FPGA Designer - [Di\gowin_p z ¥ pl\pnr\8bit_counter.rpthtmi]
7 Hle Edit Project Tools Window Help
>4 o
[ sE& U
Frocess [ it
1| Design Summary
4 [ User Constraints - PnR Messages
: PnR Messages
| FloorPlanner - PnR Details
_ 7% Timing Constraints . o Placer Report Title Gowin PrR Repert
4+ © Synthesize
. o Resource Usage Summary Design File Dr\gowin_project\8bit_counter\gbit_col
Synthesis Report
Netlist File o 1/0 Bank Usage Summary Physical Constraints File —
4 D Place & Route o Router Timing Constraints File —
Place & Route Report - Global Clock Usage Summary GOWIN Version V1.9.2Beta
Timing Analysis Rep... « Global Clock Signals Part Number GW IN-UV4PG256C6/15
Ports & Pins Report . 119:
P « Pinout by Port Name Created Time Fri Aug 16 16:19:51 2019
Power Analysis Rep... . All Package Pins Legal Announcement Copyright (C)2014-2018 Gowin Semicot
Ll Program Device
= Memory Usage
PnR Details
Placer:
Starting Placer:
Placement Phase 0 ... REAL time: 0.001 secs
« i ’
Te | Hierar Proce 7 Start Fage Tesizn Sunmary 2/ Bbit_counter.rpt.htnl [J ‘
Output & X
Info (F50002) Bitstream generation completed. ~
Info (PWDO0D1) Power analysis completed.
Info (CMO008) Generate . project\8bit_counter\8bit_counter\impl\pnr\8bit_ counter.power.html' file completed.
Info (CMD008) Generate .pin.html' file completed.
Info (CM0D008) Generate .rpt.html' file completed.
Info (CM0008) : Generate .rpt.txc' file completed.
Info (CM0008) : Generate 'D: .tr.html' file completed. E
Info (CMO001) : Fri Aug 16 16:19:51 2019
Commi t.
Output | Tssmes

ORMRE

g R VAR

* pin.html SCAF

» FEAEAT SR 2 i (g i 1 0 SO A A RS

JE Ik K DA AR B A, BRSO R4 8 pinhtml, BARE Bl &F

F P el fERE R FE X ) Place & Route [X, Xifi “Ports & Pins Report”
FTHF FPGA AN I 1y 1R PEAR 5

Bl 7-2 Ports & Plns Report

, K 7-2 Fos.

Timing Analysis Rep..
Forts & Pins Report
Power Analysis Rep.

it Program Device

Part Number
Created Time

Legal Announcement

Pinout by Port Name:

X GOWIN FPGA Designer - [D:\gowin, L e e i)
7 Fle Edit Project Tools Window Help
>F A 2
Hoxmal
Process & x -
1] Design Summary
4 [ User Constraints - Pin Messages Pi
in Messages
| FloorPlanner . Pin Details [+]
_ 1% Timing Constraints .. o Pinout by Port Name Report Title Gowin Pin Report
4 @ synthesize
el o All Package Pins Design File D:\gowin_project\gbit_counter\8bit_counter _counter.vg
Synthesis Report
Netlist File Physical Constraints File -—
4 D Place & Route Timing Constraints File —
Place & Route Report GOWIN Version V1.9.2Beta

GWIN-UVAPG256C6/I5
Fri Aug 16 16:19:51 2019

Copyright (€)2014-2019 Gowin Semiconductor Corporation. All rights reserved.

Pin Details

SUG100-1.9

| = e | Pull | Slew ;
Port Name Loc/Bank Dir. Site  |1/0Type Drive pin  SI®W| clamp openprain
datafol A153  |in_|1ol2lB] |Lvcmos1a|NA  |UP  INA NA  NA ~
- B
Tow | Hwwo | Proen 7 Start Page Design Sumary | Lt obit_comter xpt henl 7 obit_comter pinhinl (3 |
Dutpat 5 x
Info  (F30002) : Bitstream generasicn compleved. =
Info  (FWO001) : Power analysis completed.
Info  (cu0008) Di\gowin_project\8bit_counter\8bit_counter\impl\par\8bit_counter.pover.huml’ file completed.
Info  (cu0008) \gowin_pro3ect\8bit_counter\8bit_counter\impl\pnr\8bit_counter.pin.huml' file compleved.
Infe  (cM009%) project\Ebic_counter\Ebit_cowaver\impl\par\bic_cewnter.rpe.hwml' file compleved.
Infe  (cu009%) Project\Ebit_counter\fbit_cownver\impl\par\bit_cownter,Ipe.sat' file cempleved.
Info  (cu009%) \gowin_prolect\ebit_counter\8bic_cownter\impl\pnz\ebit_counter.tr.huml' file completed. £
Info (U000 i Fi Aug 16 16:19:51 2012

Conmit
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7 R T  SES 7.3 N AR

7.3 FIF#RE

) PP 1 A H SR P AP SR Y (I PR i s X U RSO AR RS 2, BRIAH
W A% =

H AT A B AR 1S G E L (R A B ORRFIS (AR 2 ik S I [l e
FEBRIN AR 7 o S /NI bk bR 28 L e R HH B AR L AT R AP 28 P 2 S50
BOAEOL X R AR B AT, JFR AR KRRk .

F P ATE S B H X 1 Place & Route X, Wi “Timing Analysis
Report” , fTJF FPGA TR NI Fpdie i, anil 7-3 Frow.
& 7-3 R FiRENA

A7 GOWIN FPGA Designer - [D:\gowin, e jmpl\pnr\8bit_counter.tr.html] felra =
 Fle Edit Broject Tools Window Help _=]x
ok R ]
filox&sU
8 x o -
Timing Messages
» Timing Summaries S
Timing Messages
STA Tool Run Summary
s Clock Summary Report Title Gowin Timing Analysis Report
esize
Symthesi Repart Max Frequency Summary Design File D:\gowin_project\8bit_counter\8bit_counter\impl\qwsynthesis\ebit_counter.vg
. - | | | Physical Constraints File
Netlist File Total Negative Slack Summa| i
) . . Timing Constraint File
4 QD Place & Route » Timing Details
Place & Route Report GOWIN version V1.9.28eta
Timing Analysis Rep... » Path Slacks Table Part Number GW1N-UVAPG256C6/15
Ports & Pins Report Setup Paths Table Created Time FriAug 16 16:19:51 2019
Power Analysis Rep.. Hold Paths Table Legal Announcemen t Copyright (C)2014-2018 Gowin Semiconductor Corporation. All rights reserved.
it Program Device Recovery Paths Table
Removal Paths Table
Minimum Pulse Width Table T|m|ng Summaries
» Timing Report By Analysis T
. STA Tool Run Summary:
Setup Analysis Report
Hold Analysis Report Setup Delay Model Slow 1.14V 85C
Recovery Analysis Report Hold Delay Model Fast 126V OC
R Numbers of Paths Analyzed 20 z
Tesw | Hierar | Proce g Start Page Design Summary ! 8bit_coumter rpt. hinl { Bbit_counter. pin. hinl 7 §bit_comter. tr. hnl £ ‘
Output 8 x
Info (F50002) : Bi:
Info (BWODO1) :
Info  (CMO00EZ)
Info (CMO008)
Info (CMDDO8)
Info (CHDDO8) r\impl\pnr\8bit_co
Info  (CMO00EZ) . px r\inpl\pnr\8bit_co
Info (CMO0OL) : Fri Rug 16 16:12:51 2019
Commit

7.4 DR E

Aty 1 BB Bk, ARYE A PF AR PRGN TG R ZhAE
RS, B PP BT A D AR E

F P el fERE FE A HEIX ) Place & Route [X, XUili “Power Analysis
Report” , AJTH FPGA TAEX N IIFE S ks, il 7-4 Fis.

A RIFED MR R, 62 _(Gowin LJ#E 7 pr 1A/ 15 )
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E 7-4 hESHRE

A GOWIN FPGA Designer - [D:A\gowin_project\8bit_counter\8bit_counter\impl\pnr\8bit_counter.power.html]

7 Hle Edit Project ook MWindew Help

]

Process

| Design Summary
4 [ User Constraints

| FloorPlanner

N

@ synthesize

Netlist File
@ Place & Route

N

L} Program Device

# Timing Constraints ...

Synthesis Report

o Pow
o Pow

Place & Route Report - Pow
Timing Analysis Rep...
Ports & Pins Report

Power Analysis Rep...

Hio=m& M

er Messages

er Summary

Power Information
Thermal Information
Configure Information
Supply Information
er Details

Power By Block Type
Power By Hierarchy

Power By Clock Domain

Power Messages

Report Title Gowin Power Analysis Report

Design File D:\gowin_project\8bit_counter\8bit_counter\imp/\gwsynthesis\8bit_counter.v—
Physical Constraints File —

Timing Constraints File -

V1.9.2Beta

GWIN-UV4PG2356CE/I5

Fri Aug 16 16:19:51 2019

GOWIN Version
Part Number
Created Time

Legal Announcement Copyright (C)2014-2019 Gowin Semiconductor Corporation. Al rights reserve

Power Summary

Power Information:

Total Power (mW) 22.848

Quiescent Power (mW) 21.298

[ [

m ] [

| #bit_counter. pin hinl

Tesw | Hierar~ | Fro . Start Page Design Sumary 7 Bbit_counter. rpt. htnl ./ 8bit_comnter. tr. htnl 7 8bit_comter power htnl [ ‘
Output & x
Info (F50002) : Bitstream generation completed. &
Info  (PWOOO1) : Pewer amalysis completed.

Info (CMO008) : Generate 'D:\gowin_project\Bbit_counter\8bit_counter\impl\pnr\gbit_counter.power.html' file completed.

Info (CM0008) : Generate 'D:\gowin_project\8bit_counter\gbit_counter\impl\pnr\Sbit_counter.pin.html' file completed.

Info (CM0008) : Generate 'D:\gowin_project\8bit_counter\ebit_counter\impl\pnr\Sbit_counter.rpt.html' file completed.

Info  (CMOOOS) : Generate 'D:\gowin project\®bit_counter\Sbit_counter\impl\pnr\Sbit_counter.rpt.wxt' file completed. T
Info  (CMO008) : Generate 'D:\gowin_project\Bbit_counter\8bit_counter\impl\pnr\8bit_counter.tr.html' file completed. e
Info (CM0001) Fri Aug 16 16:19:51 2019

Commi t
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3% A SynplifyPro J& 1 K 387w

IlﬁiA Synpl i fyPro/@4 K $& 7R

Al FwFEBRM IR

full _case

U T Verilog H1f) case 6], RUFTA A RERPIREE Oy, AFHIARRESF
WHRARRHE T IE.

B

object /* synthesis full_case */ ;

Pi B

object Ay case. casex. casez.
parallel_case

U T Verilog ' case 157], RMIAM —NIATIZ BrIEFEEEH, A ML
VR BT A

i
object /* synthesis parallel_case */ ;
L]
Object 7] 4 case. casex. casez.
translate_on/translate off

WA AR S BT, PEIEF IR . ELREn, MR T
AT AR g, R AT AR AR i N — Bl A

i
[* synthesis translate_off */
code
[* synthesis translate_on */
syn_encoding
s IR PR A LI 77
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F$3% A SynplifyPro J& M f 87w
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B
object /* synthesis syn_encoding = "value" */ ;

i

e

object J& IR FF A4 T X5

value I{EELHE:

- default: & T Ha B AR GmAD J7 30 DLk 3 5 i P gl g 1

- onehot: KH MR

- gray: KA EEHRmETT

- sequential: K BRI 4AS 775

- safe: WIARERIEAT—AIRAS IS UL FL [H] 385 A7 45

- original: WEYL T, HERFKARSPATIRENFN AT AT 145>

syn_keep
TRUEZ 4R E 1 wire FEZEE UL TP IR FEAS, Aspiilitl.
BE
object /* synthesis syn_keep = 0|1 */ ;
BB
object & wire ¥ reg X % .
syn_hier

FEHITEAALES X —~ Moudle B Component S (17301 5 ¥ 2 AL AL B , 1% ) 14
AT B 2 AR

B
f£ FDC .

define_attribute {object } syn_hier { value }

define_global_attribute syn_hier {flatten}

7t Verilog 3 #EH

object /* synthesis syn_hier =" value " */ ;

E VHDL (A

attribute syn_hier of object : architecture is " value " ;
i

syn_hier FI{H FE:

soft (FE1E): Synplify Y s st, REmfs e it 1o,

firm: R BV BT R S RO cell BSBA AL, R SUmaE E i 8T,

hard: A% (R B BT 50 1 ST A B2 FE R 1 5T

fixed: PRAFEITELICHIEE, [ B (kBT B LA AT 185 J2 Uk S AR B i 11
e

remove: EBRFIIZEMRZIR, HEARMELZ R HIT;

macro: R OR B BT ) T RN Y 2R
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o flatten: LFRFTA KT ZEMTTEZ IXRTZIRAS), Walk flatten F1H A5 2H A il
FH . 1 flatten,soft 25T flatten; flatten, firm “F I AA% T J&@ 1 BT e E R I BT A 2K
1R BE B B T I T AR B O B R AL cell 14k flatten,remove T LS &
PERTTE E AR TZE R R IR, 1EARJE 75 0 107% )8 MR AE =12 75 B X

— R 1.
loop_limit
fE verilog SCAFH, HEMARE R AR, MWEHF—NEES, f5EmAEAE
BT PR o

B

beginning_of_loop_statement /* synthesis loop_limit integer */;
syn_looplimit

fE vhdl SO, AP R AR, AR — N EIN, fREmA ST

BT PR

B

attribute syn_looplimit : integer;

attribute syn_looplimit of labelName : label is value;
syn_noprune

PR ALRAFF— A Z 4> component [RISEB, 1 ANE Hof H BE 75 58 BRIBR S o — AR
BOAZIRR G OUT AR oy o 11 P S5 22 R R SCA IS o

BE

E FDC (A

define_attribute {module|instance} syn_noprune {0|1}

7t Verilog 3 #EH

object /* synthesis syn_noprune = 1 */;

E VHDL (A

attribute syn_noprune : boolean

BB

Object 7]y module. declaration, B f] A5,
syn_preserve

FHAE RGBT () 25 A7 e Bk b, AEREER R ) Bl 25 A7 asfE AL DR AN 2N
AT A ORAF RS € IS HLE DAL ANB]

S

7t Verilog SCHEH

object /* synthesis syn_preserve =0 |1 */
E VHDL S

attribute syn_preserve of object : objectType is true | false;

L

SUG100-1.9 68(83)




F$3% A SynplifyPro J& M f 87w

object F] N7 745 € X AE 5 8 2 Module 4.

A2 SR M R FER

syn_allow_retiming
i ZF A s 2 5 ) I A & 8 4R DL S 1 R
B
£ FDC X+
define_attribute {register} syn_allow_retiming {1|0}
define_global_attribute syn_allow_retiming {1|0}
7 Verilog SCHFH
object /* synthesis syn_allow_retiming =0 | 1 */;
fE VHDL S+
attribute syn_allow_retiming of object : objectType is true | false;
syn_ramstyle

i et RAMS FOSZEL J512%, WNai A7 S BN A7 EREE . nPE i @ i il T RAM
IREN B AE 215 5 B RAM S 4 .

BE

fE FDC (A,

define_attribute { signalname [ bitRange ]} -syn_ramstyle value

define_global_attribute syn_ramstyle value

£ Verilog 3 2EH

object /* synthesis syn_ramstyle =value */

E VHDL S

attribute syn_ramstyle of object : objectType is value;

syn_romstyle

i€ ROM szl Zety, 78 Synplify Pro ] case iE4)4: il ROMs £ /b A
BRI T A RUE, TIEBER I IZ R AT ROM SEIL ROM.

i

fE FDC ST

define_attribute { romPrimitive } syn_romstyle {logic | block_ram | I[pm_rom |
MLAB | distributed | select_rom }

7t Verilog SCHEH

object /* synthesis syn_romstyle = "logic | block_ram | lpom_rom | MLAB |
distributed | select_rom" */ ;

7£ VHDL 044

attribute syn_romstyle of object : objectType is "logic | block_ram | lpm_rom |
MLAB | distributed | select_rom";
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syn_replicate

FECAI 5] 325 1) 2 47 2 O B2 o

BE

£ FDC X+

define_global_attribute syn_replicate {0 | 1};

1t Verilog X4+ :

object /* synthesis syn_replicate =1 | 0 */;

E VHDL S+

attribute syn_replicate : boolean;

attribute syn_replicate of object : signal is truelfalse;
syn_direct_enable

FHIR R SR E — 2 B BE net /A4S 4R B AR BT A R, SR T

LN A A AL

BE

E FDC (A

efine_attribute {object} syn_direct_enable {1}

£ Verilog SCHEH

object /* synthesis syn_direct_enable = 1 */;

fE VHDL S+

attribute syn_direct_enable of object : objectType is true;
syn_direct_reset

FEHIR TR R E — 2% net A4 1R € M 2D A7 A# BT Y reset .

A

£ FDC (e

define_attribute syn_direct_reset {0|1};

£ Verilog 3 2EH

object /* synthesis syn_direct_reset = 0|1*/;

E VHDL

attribute syn_direct_reset : boolean;

attribute syn_direct_reset of Object : signal is truelfalse;
syn_direct_set

FEFIR R R E — 2% net Zplic4s 45 € B R P A7 i BT Y set i

Bk

E FDC (A

define_attribute syn_direct_set {0|1};
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7t Verilog SCHEH

object /* synthesis syn_direct_set = 0|1*/;

E VHDL S+

attribute syn_direct_set : boolean;

attribute syn_direct_set of Object : signal is true|false;
syn_black _box

Syn_black_box $54 H T ¥ P il & 456, M ZBERN ARG A
{HELRA U 0 B 25l o

BE

f£ FDC (A

define_attribute { object {syn_black_box}{1}

£ Verilog 3 EH

object /* synthesis syn_black box */ ;

fE VHDL S+

attribute syn_black _box of object : objectType is true;
syn_maxfan

BB ARG . net BUAF A7 S o i B tHAE .

BE

£ FDC (e

define_attribute {object} syn_maxfan {integer}

7t Verilog 3 2EH

object /* synthesis syn_maxfan = "value" */;

fE VHDL (-

attribute syn_maxfan of object : objectType is "value";
syn_pipeline

FO VPR ERAE ST 4% J5 T 1 27 A7 e F N TV 4 SE I AR s i

A

£ FDC (e

define_attribute { register } syn_pipeline {0|1}

£ Verilog 3 2EH

object /* synthesis syn_pipeline = {1|0} */ ;

fE VHDL SCffH:

attribute syn_pipeline of object : objectType is {truel|false};
syn_probe

TN s LA A0 X A A5 5

Hi

’
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Bk

£ FDC X+

define_attribute {n:netName} syn_probe{probePortname|1|0}
7 Verilog SCHFH

object /* synthesis syn_probe = "string" | 1| 0 */;

7E VHDL SCfFH:

attribute syn_probe of object : signal is "string" | 1 | O;

syn_useenables

73 L7 A iy I A A5 B S ) 2 A4

B

£ FDC (e

define attribute {register|signal} syn_useenables {0|1}

7t Verilog 3CHEH

object /* synthesis syn_useenables = "0|1" */;

E VHDL S+

attribute syn_useenables of object : objectType is "true|false”;

syn_netlist_hierarchy

GUTE B v PUERGE JR AL R R T, T TR AR e

BE

E FDC (A

define_global_attribute syn_netlist_hierarchy {0 | 1}

1E Verilog X4+

object /* synthesis syn_netlist_hierarchy =0 | 1 */;

E VHDL S

attribute syn_netlist_hierarchy of object : objectType is true | false;
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LA it demo.y A, S A0 16 Gowin o s 8
module demo (clk_50M,rst_n,led);
input clk_50M,;
input rst_n;
output[3:0] led;
reg[3:0] led,;
reg[24:0] cnt;
reg clk_led;
always@(posedge clk_50M or negedge rst_n) begin
if (Irst_n) begin

clk_led <= 1'b0;
cnt <= 25'd0;
end
else begin

if (cnt == 25'd2499 9999) begin
clk_led <=-~clk_led;
cnt  <=25'd0;
end
else begin
cnt <=cnt + 25'd1;
end
end
end
always@ (posedge clk_led or negedge rst_n) begin
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if(Irst_n) begin

led <= 4'hi;
end
else begin
led <= {led[2:0],led[3]};
end
end
endmodule
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B.1EMTIE

FTH Gowin =IE# G52 5.1 Fi TR K 5.2 FTHF TRE#E# S TREHR
fn demo.v | TR, FCELF&UHEMSE, WE B-Fixs.

& B-1 Gowin =& IDE

A7 GOWIN FBGA Designer - [Design Summary] ==
File Edit Project Tools Window Help RO
DeHS = HoE&H
Design & X
Sbit_eomter - [0 hgowis
GHE-IVAPGZEECH Project File: Dr\gowin_project\8bit_counter\gbit_counter\gbit_counter.gprj
Verilog Files Synthesis Tool: GowinSynthesis
sre\demow
Part Number: GW IN-UV4PG256C8/15
Series: GWIN
Device: GWIN-4
Package: PBGA256
Speed Grade: Cs/Is
Core Voltage: uy
Do [ Marae [ Freew || © Start Fage Design Sumnary B |
Output a8 x

0,

B.2 iZ{TTHE
a7 TR U h
1. 7£“Process” & [, X “ Synthesize” 83 .5 AR A 1L FF “Run”,
AT H PR A AR
2. LRASEEUE, ik “Place & Route” 8435 i R bn A7 8L H: “Run”, it
1T576 Ja M R AT JR A 2k S 7= A2 bitstream SCfF, WK B-2 Fiw.



Fy3% B Beitantil

S—4= = |

E B2 EITIERE
A7 GOWIN FPGA Designer - [Design Summary]

Ele Edit Project Tools Window Help

=1 34 =N [
B o H = HicE &N
FProcess 5 X
|| Design Summary
4 [ User Constraints Project File: D:\gowin_project\8bit_counterigbit_counter\8bit_counter.gprj
3 FloorPlanner Synthesis Tacl: GowinSynthesis
Timing Constraints ...
. ® "
) Synthesize FEr——
Synthesis Report
Part Number: GW1N-UV4PG256C6/15
Netlist File
” Series: GWIN
4 (D Place & Route
Place & Route Report e GWIN-4
Timing Analysis Rep... Package: PBGA256
Ports & Pins Report Speed Grade: C6/15
Power Analysis Rep... Core Voltage: uv
I}t Program Device
Dew | Hierar | Froe- J Start Page a Design Sunmary 3] ‘
Dutput a8 x
Info (EW0001) : Power analysis completed. a
Info (cMoo08) :\gowin_project\8bit_counter\8bit_counter\impl\pnr\8bit_counter.power.html' file completed.
Info (cMoo08) in_project\8bit_counter\8bit_counter\impl\pnr\8bit_counter.pin.html' file completed.
Info (cMoo08) in_project\8bit_counter\8bit_counter\impl\pnr\8bit_counter.rpt.html' file completed.
Info (cMoo08) in_project\8bit_counter\8bit_counter\impl\pnr\8bit_counter.rpt.txt' file completed.
Info (CM0008) _project\Ebit_counter\8bit_counter\impl\pnr\Bbit_counter.tr.html' file completed.
Info (CM0001) : Fri Aug 16 16:25:40 2018 I_‘
< i v

[ comit |

B.3 T# LR

FLgEm T~ 807 X R -

1. BiTwMRAEZ G, £ “Process” % H, X “Program Device” &
FARER “Run”, $TIF FE#s05m, wE B-3 s, LHESEHBN
7 A 1 bitstream ORI R 28

2. i “ 0 7, HAT bitstream U R E
!
o  Jrnalidnt BLR 5 S AT bitstream ST #:
o [HH PRI F5.
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# B-3 THH#AR

- .
$ Programmer 2 — — ==
File Edit About
e+ ] =
Enable Family Device Operation File Checksum User Code
1 GWIN GWIN-4 SRAM Program C:/Users/root/Documents/fpga_project_12/... C5F6 0000CSFE
1] T r
Output & X
Ready
L
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Ms% C Tel fir 4Bl

Mﬁi() Tcl fp <A

1.9.1 IDE Wen 2 $EmZs, —RNTHEEHMIEmS, —FNRER
s,

C1 EahiSITIEN

C.1.1 gw_sh.exe

fir . 223 H 35 R\ x\IDE\bin\gw_sh.exe
¥ &

[script file]

[-help]

SRR HEH AN AT SR
script file: $AT—Ma & B EIA SO
-help: $TEN#EIEE.
L 746 -
#3 B an AT R
gw_sh
HIHAT A S
gw_sh.exe script_file
HTENFE G B
gw_sh.exe -help
C2IiEEEGS
C.2.1 set_option
5P
T4 : set_option
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Z¥:: [-out_dir <working dir>]
<-device <gowin device>>
[-pn <gowin part number>]
[-prj_name <project name>]
[-synplify <file>]
[-synthesis_tool <synthesis tool>]

!
[T A AT
o -out_dir: #E TAF¥ Hk. working dir %55 fI 4855 s AEN 42 . BRI 4TTIE

1T H¥,

e -device: ¥ #& device (55

e -pn: WE part number /5. gowin part number >4 pn 1H.

e -pri_name: ¥&TEA, BILA gowin.

-synplify: & synplify FTHAT SO 42842, ERCARXT 42 T 14 synplify_pro,

PRI ELEAT & o

e -synthesis_tool: #EFE 44 T E. synthesisitool, {3 synplify_pro”
J“gowinsynthesis” WiFi{H. BRIk synplify_pro.

Bz AR5l
#IE TAEE HFONEX HE “Mtest”, BRI YHTIZIT H R
set_option —out_dir ./test
#WE TFE device [ 2
set_option -device GW1N-4-LQFP144-6
#¥ E part number {5 5
set_option -pn GW1N-LV4LQ144C5/14
#IE THEA
set_option -prj_name dsp_project
# B synplify WHAT SO ER AR
set_option -synplify /home/test/ synplify_pro
HUCE I E T A

set_option -synthesis_tool synplify_pro

C.2.2 add_file
RE
fir4: add_file
ZH. [-hd< file>]
[-vm< file>]
[-cst <file>]
[-sdc<file>]
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\‘E‘ |

[-cfg<file>]
[-gpa<file>]
[-gsc<file>]
[-fdc< file>]
[-gao<file>]

[N AT IR,

-hdi< file>: #4642 HDL X

-vm< file>: #IN4 MR .

-cst <file>: N4 AL H

-sde<file>: #IN4 AR P LR,

-cfg<file>: N4 #1% device.cfg 314,

-gpa<file>: ¥sIN4z% A2 D FE 7 i & St
-gsc<file>: ¥ N4 4% gowinsynthesis [£1 51
-fde< file>: #NIN4:#%4% synplify_pro 215 SC1F .
-gao<file>: #IN4=i4% gao 1.

R RB

C.2.3 rm_file

WA

#N HDL S50

add_file -hdl /user/Desker/test.vhdl
HININ cst 29304

add_file -cst /user/Desker/test.cst

NI At 2R A B S A Y O 30 22 2R 4L

w4 rm_file
ZH: < file>
<file>: FE[R4R € MHA2H design XA, file kD, RonfaER 4

BRARSCA o AT A MR ST, SRR AR 5 40 B 42
Rz R 7=l

C.2.4 load_script

SUG100-1.9

WA

BRI B L) RO

rm_file /user/Desker/test.cst

4 load_script
ZH. <file>

<file>: file NENIZATIASCIE, AR NSRRI BIA G4
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Rz R 7Rl

HICAT A S

load_script /user/Desker/script.log
#script.log 1RG0
set_option -device GW1N-4-LQFP144-5
set_option -pn GW1N-LV4LQ144C5/14
set_option -prj_name dsp_project
set_option -synthesis_tool synplify_pro
add_file -hdl /homef/test/top.v

C.2.5 export_script

A%

g

4>: export_script
ZH: < file>

<file>: file JNfRE M T AR, O& 4. MRBIEALE
£, e,

Bz AR5l
#FH TEER
export_script /user/Desker/log
C3 RIENITHS
C.3.1 run_synthesis
B
4 : run_synthesis
ZH: [-opt <file>]

!

o [N AFEI.

o -opt <file>:file 45 [ & X synplify_pro B gowinsynthesis 13 3 14 . #1/& B-31
Fiw, =4 EIESHNZM S —1T. 448 1%, A8 A s
BATERE, GUI B WA TR & MR BN IR U . synplify_pro BT SCRF) i 4>
KA &i815iE 2% synplify_pro 75 Bh F it

C-1 synplify_pro i&BI3HFE R
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b

File
Plugins

a =

=]

[ D\gowin_project\1.2.0vrun\impl\synthesize\synthesize.cfg -
Edit

Window ?

s s &

synthesize. cfgbd |

Search View Encoding Language

MNotepad++

Settings Tools Macro Run

= =
L 0

| 4t Bg | % =

|

= e[~

| s LI O TY O U % [ )

set option
set_option
set option
set_option
set_option
set_option
set _option

—frequency 100

-maxfan 10000
-diszable io insertion 0
-update models cp O
-rw_check on ram 1
-run_prop extract 1
-symbolic fsm compiler 1

le Ln:1

Col:1

Sel

:0|0

Windows (CR LF} UTF-8

INS

-

E A=A

C.3.2 run_pnr
A%

SUG100-1.9

#E BN IE AT 5
run_synthesis
#E RO AT 45, BT SR OY 100, &K fanout 7y 1000
run_synthesis -opt synthesize.cfg
# synthesize.cfg AU
set_option -frequency 100
set_option —maxfan 1000

A

i : run_pnr

W 3
&

[-opt <file>]
[-tt]

[-ibs]

[-oc]

[-posp]

[-0]

[-timing]
[-warning_all]
[-reg_not_in_iob]
[-sdf]
[-init_all]

[ 1 AT T .
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o -opt <file>: file A5 A & X gowin LM, Wi B-32 iR, f— AN
TR —AT . P8z R, U A Z SO EEEAT place & route, GUI RS 4l
ANE E K R BT

o -tt: MR txt i, JE4tr.

o -ibs: AN ibs 3, JE4.ibs.

o -oC: AMUSERRAHRIAT, JF4. io.cst

e -posp: “EJL posp it ﬂooqﬂannerﬁiﬁ% Ja4%.posp.

o -0: Efivo X, ER.v

e -timing: KFFIKEN,

e -warning_all: fTJFTAE %4

e -reg_not_in_iob: Z%I-7F I0block [jil & DFF.

o -sdf: ApARHEIERHE A
-init_alls X REEI M BRIAWIUG1E -

. C—2 pnr ET S HE R

L.;f' *D\gowin_project\1.9.0hrun\imp\pnripnr.cfg - Notepad+ + E@
Ele Edit Search Miew Encoding Language Settings Tools Macroe Run  Plugins

Window 2 X
PRERR = N =RERIE = D2e|lékl 2tz BE|= -
= por. cfzEd |

“RR2E

-o

-init_al]

-warning all

—-timing

[ T Y O R L R P

lencLn:3 Col:10 Sel:0]0 Windows (CR LF} UTF-8 INS

Rz R =45l
#IAT place & route, A% txt £ 2 I R 5 A1 posp X
run_pnr -tt -posp
#f FHIEUCHEAT place & route, A2 R txt A% 2B 745 5 F1 posp
A
run_ pnr -opt pnr.cfg
# pnr.cfg MAEWTT:

-posp
-tt
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